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Informazioni sul presente manuale
Il presente manuale fornisce un'introduzione dettagliata a Micro FocusScreen Designer.

Il manuale descrive come:

• Creare un file della cronologia
• Utilizzare Screen Designer per personalizzare una serie di schermate
• Utilizzare le schermate personalizzate in modalità Plus.

Un'esaustiva sezione Procedure dettagliate fornisce ulteriori informazioni sulla personalizzazione delle
schermate.

Nota: È possibile personalizzare solo schermate per mainframe 3270 e sessioni 5250 AS/400
(iSeries).

Destinatari del presente manuale
Il presente manuale è rivolto a tutti coloro che sono interessati alla personalizzazione delle applicazioni
“green screen” per creare applicazioni con un aspetto più moderno.

Si prevede che i lettori sarebbero per lo più essere amministratori di sistema o personale IT con un simile
livello di competenze.

Prerequisiti
• Micro Focus Rumba+ Desktop 10.1

File allegati
Il file del pacchetto contenente questo manuale include anche i seguenti file:

• MF_logo.png
• pie_chart.png

• WebFrame_URL.txt

• welcome.png

Se non si dispone di questi file, non sarà possibile completare alcuni esercizi inclusi nel presente manuale.

Risorse aggiuntive
In aggiunta alla presente guida, sono disponibili numerosi video di formazione sul canale YuoTube Micro
Focus Support & Training:

https://www.youtube.com/playlist?list=PLlUdEXI83_XpQiv45UJauz1F0E23JaULI

Convenzioni usate nel presente manuale
Nel presente manuale, vengono usate le seguente convenzioni tipografiche:
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Questo carattere
tipografico...

Viene usato per...

Grassetto Elementi dell'interfaccia utente di Windows, come titoli di finestre, campi e pulsanti.

Utilizzato anche per i tasti della tastiera.

Monospace Elementi dell'interfaccia utente host, come titoli di schermate ed etichette.

Utilizzato anche per nomi di file e per il testo che viene richiesto di inserire.

Immissione di comandi:

Questa istruzione... Significa che...

Immettere: TSOA Digitare il comando TSOA, quindi premere il tasto Invio.
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Presentazione
È possibile utilizzare Screen Designer per fornire alle applicazioni "green screen" un aspetto più moderno
e per semplificarne l'utilizzo. È possibile effettuare queste operazioni senza toccare alcun codice
dell'applicazione.

Una volta personalizzata una serie di schermate in Screen Designer, è possibile creare un file da collegare
poi ad una sessione host. Quando viene eseguita la sessione host in modalità Plus, vengono visualizzate
le schermate modernizzate invece di quelle verdi standard.

Il presente manuale fornisce le istruzioni per iniziare ad utilizzare Screen Designer in modo da
personalizzare le schermate verdi.

Nota: Per gli scopi del presente manuale, vengono utilizzate solo le schermate mainframe 3270.
Tuttavia, è possibile anche usare le stesse istruzioni per personalizzare le schermate 5250 AS/400
(iSeries).

Terminologia
Screen Designer

Il motore di personalizzazione per Plus. È costituito da due parti:
Visualizzazione Screen Design
Utilizzata per aggiungere controlli statici a specifiche schermate.

Finestra Rule Manager
Utilizzata per aggiungere controlli dinamici o condizionali a più schermate.

Controllo
Un moderno elemento visivo che interagisce con una schermata verde. Ad esempio, un
pulsante.

Regola
Un meccanismo che crea automaticamente uno o più controlli condizionali su una o più
schermate, gestite da regole.

Plus
Il middleware utilizzato per eseguire applicazioni "schermata verde" con un'interfaccia
moderna tramite i progetti creati in Screen Designer.

archivio Plus
Una raccolta di file e impostazioni che definiscono le personalizzazioni della schermata
create in Screen Designer e utilizzate in una sessione host Plus.

Come funziona
La figura sottostante fornisce una panoramica delle operazioni necessarie per creare e utilizzare le
schermate personalizzate:
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Architettura

Novità di questa versione
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Utilizzo del Screen Designer
Questa sezione fornisce una guida dettagliata per la creazione di un progetto di personalizzazione. È
possibile aggiungere una serie di controlli in varie schermate verdi per creare un progetto, quindi
visualizzare i risultati della personalizzazione in modalità Plus.

Introduzione
Prima di iniziare a utilizzare Screen Designer, è necessario:
• Estrarre i file forniti con il presente manuale.
• Avviare una sessione mainframe.
• Modificare il colore del testo della schermata per renderlo più visibile.
• Configurare la connessione a Demo Host.

Estrazione dei file del pacchetto
Estrarre i seguenti file dal di pacchetto .ZIP sul computer locale:
• MF_Logo.png
• pie_chart.png
• WebFrame_URL.txt
• welcome.png

Annotare la posizione in cui si salvano i file perché sarà necessaria in seguito.

Avvio di una sessione mainframe
1. Dal menu Start di Windows, selezionare: 

Start > Tutti i programmi > Micro Focus Rumba+ Desktop > Rumba+ DesktopRumba+ Desktop

Viene visualizzata la schermata iniziale:
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2. Fare clic su Mainframe Display. 

Una finestra di sessione mainframe viene visualizzata in Rumba+ Desktop.

Configurazione della connessione a Demo Host

1. Selezionare Connection > Configure. 

Viene visualizzata la finestra di dialogo Configurazione sessione.

2. Nella pagina Connessioni, selezionare Connessione automatica.

3. Selezionare Demo Host dall'elenco Interfacce installate.

4. Fare clic su OK.

5. Selezionare File > Save session Profile As. 

Viene visualizzata la finestra di dialogo Save Session Profile.

6. Nel campo Nome file, digitare DemoHost.

7. Fare clic su OK.

Modifica dei colori della schermata
Alcune schermate utilizzate da Demo Host possono presentare problemi di visualizzazione a causa del
colore blu del testo utilizzato. Una semplice soluzione consiste nel modificare il colore del testo.

Per eseguire questa operazione:

1. Selezionare Options > Display. 

Viene visualizzata la finestra di dialogo Display Options.

2. Fare clic sulla scheda Color Attributes.

3. Nel riquadro Multi Color Attributes, fare clic sul pulsante Protected. 

Viene visualizzata la tavolozza dei colori:

4. Fare clic sulla casella verde chiaro. 
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Il pulsante Protected cambia in verde.

5. Nel riquadro Extended Color Attributes, fare clic sul pulsante Blue. 

Viene visualizzata la tavolozza dei colori:

6. Fare clic sulla casella verde chiaro. 

Il pulsante blu cambia in verde.

7. Fare clic su OK. 

Tutto il testo visualizzato nelle schermate in blu scuro viene ora visualizzato in verde.

Creazione di un file della cronologia
Prima di iniziare la personalizzazione delle schermate, è necessario acquisire una serie di schermate in un
file della cronologia. Questa sezione descrive come registrare una sequenza di schermate da utilizzare in
Screen Designer.

Registrazione della cronologia
Per creare un file della cronologia:

1. Fare clic sull'icona Cronologia  nella barra degli strumenti di Rumba+. 

Viene visualizzato il pannello History.

2. Fare clic sull'icona Record  nella barra degli strumenti del pannello History.

3. Selezionare Connection > Connect. 

Viene avviata la sessione mainframe Demo Host:
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4. Nel prompt ENTER SYSTEM ID :, immettere: 

TSOA

Le schermate iniziano ad essere registrate.

5. Nel prompt ENTER LOGON ID:, premere Invio.

6. Nel prompt LAST SYSTEM ACCESS, premere Invio. 

Viene visualizzato il prompt READY.

7. Fare clic sull'icona Acquisizione manuale  nella barra degli strumenti del pannello Cronologia. 

Viene descritto come acquisire singole schermate. Esistono due motivi per acquisire uno schermo
manualmente:

• È stata disattivata la cronologia delle schermate, ma è necessario acquisire una schermata.
• Sono stati modificati uno o più campi non protetti su una schermata e si desidera acquisire la

schermata con le modifiche.

8. Immettere: 

TOYS

9. Nella schermata TOPCO TOYS, INC, premere Invio.

10.Immettere O.

11.Nella CUSTOMER SCREEN, premere PF8.

12.Nella DETAIL LINE ENTRY SCREEN, premere Invio.

13.Nel prompt READY, immettere: 

E

14.Nella schermata TOP OF DATA, premere Invio.

15.Nel prompt READY, immettere: 

R

16.Nella schermata TOPCO TOYS, INC, premere PF3.

17.Nel prompt READY, immettere: 

A

18.Nella schermata EXTENDED ATTRIBUTE TEST, premere PF3.

19.Nel prompt READY, immettere: 

C
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Viene visualizzata la schermata EUROPEAN CUSTOMER LIST.

20.Premere PF1.

21.Fare clic nuovamente sull'icona Record  per interrompere la registrazione della cronologia.

Ciascuna schermata è stata aggiunta, in sequenza, al pannello History:

Salvataggio della cronologia in un file
Per salvare la cronologia registrata in un file:

1. Fare clic sull'icona Export history to file  nella barra degli strumenti del pannello History. 

Viene visualizzata la finestra di dialogo History Export.

2. Accedere alla posizione in cui si desidera salvare il file della cronologia.

3. Nel campo Nome file, digitare DemoHistory.

4. Fare clic su Salva. 

Sarà ora disponibile una serie di schermate da poter utilizzare nel progetto di personalizzazione.

5. Fare clic sull'icona Cronologia  nella barra degli strumenti di Rumba+. 

Il pannello History viene chiuso.

6. Selezionare Connessione > Disconnetti.

Apertura di Screen Designer
Per aprire Screen Designer, selezionare Plus > Apri Screen Designer.

Viene visualizzata la finestra Screen Designer:
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Barra degli strumenti e barra dei menu di Screen Designer.

Pannello cronologia. Contiene le miniature di tutte le schermate registrate nel file della
cronologia importato, insieme ad una casella di ricerca che consente di cercare e filtrare le
schermate.

Area di lavoro. Contiene una versione di grandezza standard della miniatura selezionata.
Mostra i controlli associati alla schermata.

Pannello di controllo. Contiene un elenco dei controlli disponibili da poter applicare alla
schermata nell'area di lavoro.

Griglia delle proprietà. Contiene un elenco delle proprietà disponibili per il controllo
selezionato.

Descrizione delle proprietà. Fornisce una descrizione della proprietà selezionata nella griglia
delle proprietà.

Barra di stato. Visualizza le coordinate del cursore. Utile durante la ricerca delle coordinate dei
campi.

Avvio di un nuovo progetto

1. Selezionare File > Nuovo progetto.

Viene visualizzata la finestra di dialogo Nuovo progetto.

2. Nel campo Nome, digitare un nome per il progetto, come DemoHost, quindi fare clic su OK.

Importazione della cronologia

1. Selezionare File > Importa cronologia. 

Viene visualizzata la finestra di dialogo Importazione cronologia.

2. Scegliere il file della cronologia, quindi fare clic su Apri. 
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Verranno visualizzate le miniature delle schermate registrate nel riquadro della cronologia. Ogni
schermata presenta un ID univoco. È, inoltre, possibile creare ID della schermata invece di, o in
aggiunta a, questo ID predefinito (vedere Identificazione delle schermate).

La prima schermata è selezionata per impostazione predefinita e una sua versione più grande viene
visualizzata nell'area di lavoro:

3. Selezionare File > Salva progetto. 

Nota: È sempre consigliabile salvare il progetto dopo averlo modificato.

Selezione di un tema
Un tema definisce il layout della schermata e l'aspetto di ogni controllo su tutte le schermate in un progetto
di personalizzazione.

Si consiglia vivamente di scegliere un tema nelle prime fasi del progetto di personalizzazione.

Per selezionare un tema:

1. Selezionare Strumenti > Impostazioni progetto

Viene visualizzata la finestra di dialogo Impostazioni progetto.

2. Fare clic su Temi nel riquadro a sinistra.

3. Fare clic su Modifica nel riquadro a destra. Viene visualizzata la finestra di dialogo Scegli tema.

4. Nel riquadro a sinistra, selezionare la miniatura Plus Windows Theme.

5. Fare clic su OK.

6. Fare clic su OK nella finestra di dialogo Impostazioni progetto. 

Il tema verrà applicato a tutte le schermate del progetto.

Per ulteriori informazioni sui temi, vedere Utilizzo dei temi.

Aggiunta di controlli
Ora, verrà utilizzata la visualizzazione Screen Design per aggiungere controlli alle schermate.
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Verrà utilizzata la visualizzazione Screen Design per aggiungere controlli statici a specifiche schermate.
Per aggiungere controlli dinamici, controlli che si ripetono su più schermate o più volte su una singola
schermata, utilizzare Rule Manager. Per informazioni su Rule Manager, vedere Utilizzo di Rule Manager.

Man mano che si procede in questa sezione, i controlli vengono aggiunti progressivamente alle schermate
acquisite. Si consiglia di aggiungere i controlli nell'ordine in cui sono descritti per realizzare un progetto
completo.

Nota: È importante ricordare che, benché Screen Designer sia uno strumento molto potente, non si
tratta di WYSIWYG. È consigliabile sempre adottare un approccio di progettazione e test tale da
assicurarsi che le operazioni effettuate in Screen Designer abbiano l'aspetto desiderato in modalità
Screen Designer.

Aggiunta di un controllo Button
Button attiva un'azione o una sequenza di azioni quando si fa clic su di esso.

Nota: In questa sezione, è necessario utilizzare il file MF_Logo.png fornito con il file del pacchetto.

1. Assicurarsi di aver selezionato la prima miniatura.

2. Trascinare l'icona del controllo Button dal pannello di controllo nell'area di lavoro e rilasciarla a sinistra
della riga AVAILABLE SYSTEM IDS ARE. 

Nota: Una volta trascinato il controllo sulla schermata, viene popolata la griglia delle proprietà.

3. Nella griglia delle proprietà, fare clic nel campo Caption ed eliminare il testo Button.

4. Digitare Micro Focus SupportLine. 

Facendo clic in un punto qualsiasi della schermata, il testo sul controllo cambia.

5. Per visualizzare il testo su due righe, fare clic nel campo Caption e posizionare il cursore dopo Micro
Focus, quindi premere Alt+Invio. La riga viene suddivisa.

6. Utilizzare gli angoli di ridimensionamento del controllo per adattarlo al testo.

7. Fare clic nel campo Tooltip e digitare SupportLine Web Site. 
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8. Fare clic sul pulsante acceleratore  vicino al campo Actions. 

Viene visualizzata la finestra di dialogo Actions.

9. In Select type, selezionare WebSite dall'elenco a discesa.

10.Fare clic su Add. 

Vengono visualizzate una nuova azione nel riquadro Actions e le relative proprietà nel riquadro
Properties.

11.Nel riquadro Properties, digitare http://www.microfocus.com/supportline nel campo
WebSiteAddress: 

12.Fare clic su OK.

13.Utilizzare gli angoli di ridimensionamento sul controllo per adattarlo al testo. 

La schermata sarà simile a quella riportata di seguito:

14.È anche possibile utilizzare un'immagine per il pulsante invece del testo. Per effettuare questa
operazione, selezionare Image dall'elenco Mode.
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15.Fare clic sul pulsante acceleratore vicino al campo ImagePath. 

Viene visualizzata la finestra di dialogo Choose Image.

16.Fare clic su  vicino a Add to pool.

17.Accedere alla posizione in cui è stato salvato il file MF_Logo.png, selezionarlo e fare clic su Open
Open

18.Assicurarsi che l'immagine sia selezionata nella finestra di dialogo Scegli immagine e fare clic su OK. 

L'immagine viene visualizzata sul pulsante.

19.Utilizzare gli angoli di ridimensionamento sul pulsante per riadattarlo alla dimensione 6x1. 

La schermata sarà simile a quella riportata di seguito:

Nota: È possibile anche fornire un collegamento ad un'immagine non presente sul proprio
computer. Per effettuare questa operazione, digitare l'indirizzo Web dell'immagine nel campo
ImagePath.

20.Selezionare File > Salva progetto.

Aggiunta di un controllo Chooser
Il controllo Chooser viene visualizzato sulla schermata come un elenco a discesa. Chooser viene utilizzato
per inserire dati nel campo sulla schermata selezionando una voce dall'elenco.

1. Trascinare l'icona del controllo Chooser dal pannello di controllo nell'area di lavoro e rilasciarla in cima
all'elenco TSOA sulla riga ENTER SYSTEM ID:: 
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2. Nella griglia delle proprietà, fare clic sul pulsante acceleratore  vicino a ChooserItems. 

Viene visualizzata la finestra di dialogo ChooserItems.

3. Fare clic sul pulsante Aggiungi .

4. Nel riquadro Properties, digitare Select Host nel campo Caption.

5. Nel campo Tooltip, digitare Select host system. 

Questo testo verrà visualizzato quando si sposta il mouse sull'opzione. È possibile usare il testo della
descrizione del comando per trovare suggerimenti e utili informazioni sull'opzione.

6. Lasciare vuoto il campo ValueToInsert.

7. Fare clic sul pulsante Aggiungi .

8. Nel riquadro Properties, digitare WYLBUR nel campo Caption.

9. Nel campo Tooltip, digitare Select WYLBUR.

10.Nel campo ValueToInsert, digitare WYL. 

Questo testo verrà posizionato nel campo di immissione e deve corrispondere ai controlli che vengono
di solito digitati manualmente nel campo.

La finestra di dialogo ChooserItems sarà simile a quella riportata di seguito:
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11.Ripetere la procedura riportata sopra per aggiungere le seguenti voci del controllo Chooser: 

Caption Tooltip Valore da inserire

TSO MVS/XA Select TSO MVS/XA TSOA

TSO MVS/XB Select TSO MVS/XB TSOQ

VM/370 Select VM/370 VM

Al termine, la finestra di dialogo Chooser sarà simile a quella riportata di seguito:

12.Al termine, fare clic su OK.

13.Utilizzare gli angoli di ridimensionamento sul controllo per adattarlo in modo da visualizzare il testo
correttamente. 

La schermata sarà simile a quella riportata di seguito:
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14.Nella griglia delle proprietà, fare clic sul pulsante acceleratore  vicino a TextInsertionLocation. 

Viene visualizzata la finestra Selezionare la posizione della schermata.

15.Selezionare Posizione dall'elenco Seleziona per in fondo alla finestra.

16.Fare clic sulla T di TSOA a destra di ENTER SYSTEM ID: nella posizione 12,29.

17.Fare clic su OK.

18.Nella griglia delle proprietà, fare clic sul pulsante acceleratore  vicino a Actions. 

Viene visualizzata la finestra di dialogo Actions.

19.Dall'elenco Select type, selezionare EmulationCommand.

20.Fare clic su Add.

21.Dall'elenco Action, selezionare Enter. 

Questa azione invia un comando Enter all'host una volta inviato il testo selezionato dal controllo
Chooser alla posizione della schermata specificata da TextInsertionLocation.

22.Fare clic su OK.

23.Selezionare File > Salva progetto.

Aggiunta di un controllo Tooltip
Tooltip visualizza il testo al passaggio del mouse sull'area della schermata occupata da Tooltip.

1. Trascinare l'icona del controllo Tooltip dal pannello di controllo nell'area di lavoro e rilasciarla sopra
ENTER SYSTEM ID: ENTER SYSTEM ID:

2. Trascinare gli angoli di ridimensionamento sul controllo in modo da coprire il testo della schermata: 
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3. Nella griglia delle proprietà, digitare quanto segue nel campo Caption: 

Click drop-down list to select system

4. Fare clic nel campo Caption e posizionare il cursore proprio prima di to.
5. Premere Alt+Invio. 

La riga si divide in due parti.
6. Selezionare File > Salva progetto.

Aggiunta di un controllo AutoExecution
Una volta effettuato l'accesso a Demo Host, è necessario premere due volte Enter per visualizzare il
prompt READY. È possibile utilizzare un controllo AutoExecution per automatizzare questa sequenza. Per
eseguire questa operazione:
1. Nel riquadro a sinistra, selezionare la seconda schermata. 

Nell'area di lavoro, viene visualizzata una versione più grande della schermata.
2. Trascinare il controllo dal pannello di controllo e rilasciarlo a destra dell'icona AutoExecution: 
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3. Nella griglia delle proprietà, fare clic sul pulsante acceleratore  vicino al campo Actions.

4. Dall'elenco Select type, selezionare Emulation Command. 

5. Fare clic su Add.

6. Dall'elenco Action, selezionare Enter.

7. Fare clic su OK.

8. Selezionare la terza schermata nel riquadro a sinistra:

9. Aggiungere un altro controllo AutoExecution e assegnargli le stesse proprietà: 

10.Selezionare File > Salva progetto.

Aggiunta di un controllo Image
Image nasconde un'area di una schermata con un colore o un'immagine.

Nota: In questa sezione, è necessario utilizzare il file welcome.png fornito con il file del pacchetto.

1. Nel riquadro della cronologia, scorrere verso il basso e selezionare la quarta miniatura. In tal modo,
viene visualizzato il prompt READY. 

Nell'area di lavoro, viene visualizzata una versione più grande della schermata:
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2. Trascinare l'icona del controllo Image dal pannello di controllo sull'area di lavoro, quindi utilizzare gli
angoli di ridimensionamento per adattarlo alla dimensione 15x66: 

3. Nella griglia delle proprietà, selezionare Image dall'elenco a discesa Type. 

Viene visualizzato il campo ImagePath.

4. Fare clic sul pulsante acceleratore  vicino al campo ImagePath. 

Viene visualizzata la finestra di dialogo Choose Image.

5. Fare clic su  vicino a Add to pool.

6. Accedere alla posizione in cui è stato salvato il file welcome.jpg, selezionarlo e fare clic su Open.

7. Assicurarsi che l'immagine sia selezionata nella finestra di dialogo Scegli immagine e fare clic su OK. 

L'immagine selezionata ora riempie il controllo sulla schermata:
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Nota: È possibile anche fornire un collegamento ad un'immagine non presente sul proprio
computer. Per effettuare questa operazione, digitare l'indirizzo Web dell'immagine nel campo
ImagePath.

8. Selezionare File > Salva progetto.

Aggiunta di un controllo MessageBox
Il controllo MessageBox è una casella per il messaggio di avviso che può essere configurata con un titolo,
un'icona, da uno a tre pulsanti e un messaggio.

1. Sulla schermata READY, trascinare un'icona MessageBox dalla griglia delle proprietà sull'area di lavoro
e rilasciarla sull'immagine appena creata: 

2. Nella griglia delle proprietà, digitare Warning in Title.

3. Nel campo Text, digitare This system is restricted. Click OK to continue or Cancel
to log off.
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4. Nella sezione Button con Caption di Cancel, fare clic sul pulsante acceleratore vicino ad Actions: 

Viene visualizzata la finestra di dialogo Actions:

5. Dall'elenco Select type, selezionare SetText, quindi fare clic su Add.

6. Nel riquadro Properties, digitare logoff nel campo Text.

7. Fare clic sul pulsante acceleratore vicino al campo TextInsertionLocation. Viene visualizzata la
finestra Selezionare la posizione della schermata.

8. Selezionare Location dall'elenco Select By.

9. Fare clic una volta in R di READY. Si tratta della riga 2, colonna 2.

10.Fare clic su OK. 

La finestra di dialogo Actions sarà simile a quella riportata di seguito:

11.Dall'elenco Select type, selezionare EmulationCommand, quindi fare clic su Add.

12.Nel riquadro Properties, selezionare Enter dall'elenco EmulationCommand. 

La finestra di dialogo Actions sarà simile a quella riportata di seguito:

13.Fare clic su OK.

14.Selezionare File > Salva progetto.

Utilizzo del Screen Designer | 27



Aggiunta di un controllo Label
Label aggiunge un'etichetta di testo ad una schermata verde. È possibile utilizzare Label per sostituire
un'etichetta di testo esistente o per creare una nuova etichetta.

1. Nel riquadro della cronologia, selezionare la schermata SALES ORDER ENTRY - CUSTOMER
SCREEN. 

Nell'area di lavoro, viene visualizzata una versione più grande della schermata.

2. Trascinare l'icona del controllo Label dal pannello di controllo nell'area di lavoro e rilasciarla in cima al
campo Contract.

3. Ridimensionare il controllo in modo da coprire completamente il campo: 

4. Nella griglia delle proprietà, deselezionare HostText. 

Viene visualizzato il campo LabelText.

5. Nel campo LabelText, eliminare il testo predefinito Label e digitare Order Number:. Date:

6. Selezionare Right dall'elenco Alignment.

7. Nel riquadro ColorSettings, selezionare FromHost in Background e FromHost in Foreground. 

Il controllo ora utilizza i colori di sfondo e di primo piano della schermata per il testo e lo sfondo
dell'etichetta. Il testo dell'etichetta ora è visibile nel controllo:
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8. Selezionare File > Salva progetto.

Aggiunta di un controllo Calendar
Calendar inserisce la data selezionata nel punto specificato sulla schermata.

1. Assicurarsi che la schermata SALES ORDER ENTRY - CUSTOMER SCREEN sia ancora visualizzata
nell'area di lavoro.

2. Trascinare l'icona del controllo Calendar dal pannello di controllo nell'area di lavoro e rilasciarla a
sinistra del (nuovo) campo Date: 

3. Nella griglia delle proprietà, fare clic sul pulsante acceleratore  vicino al campo InsertedDateFormat.

Viene visualizzata la finestra di dialogo Date Format.
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È possibile scegliere tra una varietà di formati di data disponibili. In alternativa, è possibile specificare
un formato di data personalizzato.

4. Selezionare MM-dd-yy dall'elenco delle date, quindi fare clic su OK. 

La finestra di dialogo verrà chiusa e verrà visualizzato il formato di data nel campo
InsertedDateFormat.

5. Nel campo Tooltip, digitare Select date Select date

6. Fare clic sul pulsante acceleratore  vicino al campo TextInsertionLocation. 

Viene visualizzata la finestra Selezionare la posizione della schermata.

7. Selezionare Location dall'elenco Select By.

8. Fare clic su uno spazio a destra del campo Contract nella posizione della schermata (3,52).

9. Fare clic su OK. 

La finestra di dialogo verrà chiusa e verranno visualizzate le coordinate nel campo
TextInsertionLocation. In questo caso, 3,52. Le coordinate vengono anche visualizzate nella barra di
stato, sotto la griglia delle proprietà.

Al termine, la griglia delle proprietà sarà simile a quella riportata di seguito:

10.Selezionare File > Salva progetto.

Aggiunta di un controllo GridCollector
GridCollector raccoglie le informazioni da una posizione specifica della schermata e le visualizza in una
tabella.

1. Nel riquadro a sinistra, scorrere verso il basso e selezionare la schermata EUROPEAN CUSTOMER
LIST.

2. Trascinare il controllo GridCollector dal pannello di controllo e rilasciarlo all'inizio della prima riga: 
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3. Nella griglia delle proprietà, nel campo Name, eliminare GridCollector1 e digitare CustomerList.

4. Fare clic sull'icona Edit  sul controllo. 

Viene visualizzato il riquadro GridCollector:

5. Spostare e ridimensionare il riquadro GridCollector in modo da sovrapporlo ai dati della schermata: 
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6. Fare clic sul pulsante acceleratore  vicino al campo Columns. 

Viene visualizzata la finestra di dialogo Columns.

7. Nel campo Name, eliminare GridCollectorColumn e digitare Account.

8. Fare clic sul pulsante Add . 

Un'altra voce viene visualizzata nel riquadro Column.

9. Nel campo Name, digitare Sales Rep.

10.Fare clic sul pulsante Add . 

Un'altra voce viene visualizzata nel riquadro Column.

11.Continuare ad aggiungere colonne per:

• Vol/Yr

• Cum Rev

• Country

La finestra di dialogo sarà simile a quella riportata di seguito:
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12.Fare clic su OK. 

Il riquadro GridCollector ora contiene una serie di linee blu verticali. Queste linee rappresentano i
divisori delle colonne.

13.Trascinare ciascun divisore di colonna a sinistra di ciascuna colonna. 

La schermata GridCollector sarà simile a quella riportata di seguito:

Suggerimento: In alcuni casi, come le applicazioni Web, i parametri di sistema non cercano spazi
iniziali. Pertanto, è meglio iniziare una colonna sul primo carattere dei dati.

14.In alto a destra rispetto a GridCollector, fare clic sull'icona Save .

15.Selezionare File > Salva progetto.

Aggiunta di un controllo Table
Questa sezione descrive come aggiungere un controllo Table per visualizzare i dati raccolti dal controllo
Table.

1. Trascinare il controllo dalla griglia delle proprietà e rilasciarlo sul controllo Table. 

La tabella si collega automaticamente al controllo GridCollector e viene mappata all'area definita da
GridCollector:
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Nota: Il campo LinkedGridCollectorName nella proprietà viene compilato automaticamente e
l'intestazione della tabella e le proprietà delle colonne vengono ricavate dalle proprietà collegate
GridCollector.

2. Deselezionare IsMoreButtonVisible.

3. Deselezionare IsAutoNavigateOnLoad.

4. Selezionare IsExportButtonVisible. 

Nota: Il pulsante More non viene più visualizzato nella tabella e viene sostituito dal pulsante
Export.

5. Selezionare File > Salva progetto.

Aggiunta di un controllo Collector
Collector controlla la raccolta dei dati della schermata per l'utilizzo in altre funzioni. In questo caso, viene
aggiunto un controllo Collector per raccogliere i dati necessari per generare un grafico a torta per il mese
di gennaio.

1. Nel riquadro della cronologia, selezionare la schermata TOPCO TOYS, INC Revenue Analysis By
Region. 

2. Trascinare l'icona del controllo Collector dal pannello di controllo nell'area di lavoro e rilasciarla sopra il
numero 305 nella colonna JAN per l'area 1: 
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3. Nella griglia delle proprietà, digitare R1Jtoy nel campo Name. 

Questo è il nome della variabile con cui verrà memorizzato il valore.

4. Lasciare selezionata l'opzione TrimSpaces.

5. Aggiungere i controlli Collector per le altre tre aree. Utilizzare R2Jtoy, R3Jtoy e R4Jtoy come nomi
dei parametri globali. 

La schermata sarà simile a quella riportata di seguito:

6. Selezionare File > Salva progetto.

Aggiunta di un controllo WebFrame
Nella sezione precedente, sono stati aggiunti quattro controlli Collector in modo da raccogliere i dati per un
grafico a torta. Ora, verrà aggiunto un controllo WebFrame per utilizzare le variabili dei controlli WebFrame
in modo da generare il grafico a torta.
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Nota: In questa sezione, è necessario utilizzare il file WebFrame_URL.txt e i file pie chart.png
forniti con il file del pacchetto.

1. Trascinare l'icona del controllo WebFrame dal pannello di controllo nell'area di lavoro e rilasciarla
proprio sotto JAN: 

2. Selezionare Pop-up dall'elenco Mode. 

Nota: Se si seleziona Embedded, il grafico a torta risultante viene visualizzato come una finestra
incorporata nella schermata verde.

3. Fare clic sul pulsante acceleratore  vicino al campo ImagePath. 

Viene visualizzata la finestra di dialogo Choose Image.

4. Fare clic su  vicino a Add to pool.

5. Accedere alla posizione in cui è stato salvato il file pie chart.png, selezionarlo e fare clic su Open.

6. Assicurarsi che l'immagine sia selezionata nella finestra di dialogo Scegli immagine e fare clic su OK.

7. Nel campo Tooltip, digitare Pie chart.

8. Aprire il file WebFrame_URL.txt. 

Il file contiene il seguente URL:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%
%&chdl=Region1|Region2|Region3|Region4&chtt=TOYS

9. Copiare il contenuto del file e incollarlo nel campo URLSource.

10.Selezionare File > Salva progetto.

Aggiunta di un controllo Tab
Tab fornisce un'area della schermata alla quale assegnare altri controlli. È possibile avere più controlli Tab
su una schermata, con più voci Tab all'interno di un controllo Tab.

1. Nel riquadro della cronologia, selezionare la schermata SALES ORDER ENTRY - DETAIL LINE
ENTRY SCREEN. 

Nell'area di lavoro, viene visualizzata una versione più grande della schermata.
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2. Trascinare l'icona del controllo Tab dal pannello di controllo nell'area di lavoro e rilasciarla sull'area
Remarks nella schermata: 

3. Nella griglia delle proprietà, fare clic sul pulsante acceleratore  vicino al campo TabItems. 

Viene visualizzata la finestra di dialogo TabItems.

4. Nel campo Caption, eliminare Tab Item e digitare Order.

5. Fare clic sul pulsante Add . 

Un'altra voce viene visualizzata nel riquadro Properties.

6. Nel campo Caption, eliminare Tab Item e digitare Quantity.

7. Fare clic sul pulsante Add . 

Un'altra voce viene visualizzata nel riquadro Properties.

8. Nel campo Caption, eliminare Tab Item e digitare Approved. 

La finestra di dialogo sarà simile a quella riportata di seguito:
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9. Fare clic su OK. 

Il controllo Tab ora dispone di tre voci Tab:

È possibile scegliere la larghezza delle intestazioni delle voci di scheda per adattare il testo selezionato.
Ad esempio, la larghezza predefinita è di otto caratteri. È possibile specificare un'altra larghezza
modificando il valore nel campo HeaderSize nella griglia delle proprietà.

10.Modificare il valore nel campo HeaderSize in 12. 

È possibile vedere la modifica nella larghezza delle intestazioni delle voci di scheda.

Nota: Selezionando Dynamic dall'elenco HeaderWidth, le intestazioni si ridimensionano
automaticamente per adattare la lunghezza del testo in ciascuna intestazione.

11.Nel riquadro ColorSettings, selezionare Custom in Background, quindi fare clic sul pulsante giù 
per aprire la tavolozza dei colori Available Colors.

12.Selezionare RoyalBlue: 

Il colore riempie il controllo Tab e le relative voci Tab:
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13.Selezionare File > Salva progetto.

Aggiunta di un controllo InputField
InputField fornisce un campo di inserimento di testo in cui è possibile digitare il testo in una posizione
specifica della schermata.

1. Ogni campo di inserimento richiede un'etichetta. Trascinare l'icona del controllo dal pannello di controllo
e rilasciarla sul controllo Label che è stato creato: 

2. Nella griglia delle proprietà, deselezionare HostText. 

Viene visualizzato il campo LabelText.

3. Nel campo LabelText, eliminare il testo predefinito Label e digitare Order Number:.

4. Aggiungere un altro controllo Label sotto il primo e denominarlo Status:.

5. Ridimensionare entrambe le etichette: 

6. Trascinare l'icona del controllo InputField dal pannello di controllo e rilasciarla sulla riga Order Number:

7. Fare clic sul pulsante acceleratore  vicino al campo TextInsertionLocation. 

Viene visualizzata la finestra Selezionare la posizione della schermata.

8. Selezionare Location dall'elenco a discesa Select By.

9. Fare clic nel campo Order Number, quindi fare clic su OK. 

Le coordinate 3,16 vengono visualizzate nel campo TextInsertionLocation.

10.Nel riquadro ColorSettings, selezionare FromHost in Background e FromHost in Foreground. 

Il controllo ora utilizza i colori di sfondo e primo piano della schermata.

La voce Tab sarà simile a quella riportata di seguito:
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11.Fare clic sulla scheda Quantity.

12.Trascinare l'icona del controllo Label sulla voce di scheda.

13.Deselezionare HostText e denominare l'etichetta Product Number:.

14.Ridimensionare l'etichetta.

15.Aggiungere un'altra etichetta sotto la prima, denominarla Quantity:, quindi ridimensionarla. 

La voce Tab sarà simile a quella riportata di seguito:

16.Aggiungere un controllo InputField nella riga Product Number.

17.Fare clic sul pulsante acceleratore  vicino al campo TextInsertionLocation per aprire la finestra
Screen Location.

18.Selezionare Location dall'elenco a discesa Select By.

19.Fare clic nel campo Product Number, quindi fare clic su OK. 

Le coordinate 6,18 vengono visualizzate nel campo TextInsertionLocation.

20.Nel riquadro ColorSettings, selezionare FromHost in Background e FromHost in Foreground. 

Il controllo ora utilizza i colori di sfondo e primo piano della schermata.

21.Aggiungere un controllo InputField nella riga Quantity.

22.Aprire la finestra Screen Location e fare clic nel campo Order Qty.

23.Fare clic su OK. 

Le coordinate 8,18 vengono visualizzate nel campo TextInsertionLocation.

24.Nel riquadro ColorSettings, selezionare FromHost in Background e FromHost in Foreground. 

La voce Tab sarà simile a quella riportata di seguito:

25.Fare clic sulla scheda Approved.

26.Trascinare l'icona del controllo Label sulla voce di scheda.

27.Deselezionare HostText, denominare l'etichetta Approval:, quindi ridimensionarla: 

28.Selezionare File > Salva progetto.
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Aggiunta di un controllo RadioButton
RadioButton invia il testo ad una posizione della schermata specificata.

Questa sezione utilizza il controllo Tab creato in precedenza.

1. Fare clic sulla scheda Order: 

2. Trascinare il controllo RadioButton dal pannello di controllo e rilasciarlo sulla riga Status: 

3. Nella griglia delle proprietà, eliminare RadioButton dal campo Caption e digitare Open.

4. Nel campo GroupName, digitare OrderStatus.

5. Aprire la finestra Screen Location utilizzando il pulsante acceleratore TextInsertionLocation.

6. Selezionare Location dall'elenco a discesa Select By.

7. Fare clic nel campo Status sulla riga superiore della schermata verde.

8. Fare clic su OK. 

Le coordinate 3,33 vengono visualizzate nel campo TextInsertionLocation.

9. Nel campo TextToSend, digitare Open. 

La griglia delle proprietà sarà simile a quella riportata di seguito:

10.Trascinare il controllo RadioButton dalla griglia delle proprietà e rilasciarlo sotto il pulsante di opzione
Open: 
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11.Nella griglia delle proprietà, eliminare RadioButton dal campo Caption e digitare Shipped.

12.Nel campo GroupName, digitare OrderStatus.

13.Aprire la finestra Screen Location utilizzando il pulsante acceleratore TextInsertionLocation.

14.Selezionare Location dall'elenco a discesa Select By.

15.Fare clic nel campo Status sulla riga superiore della schermata verde.

16.Fare clic su OK. 

Le coordinate 3,33 vengono visualizzate nel campo TextInsertionLocation.

17.Nel campo TextToSend, digitare Shipped.

18.Fare clic sul pulsante acceleratore  vicino al campo Actions. 

Viene visualizzata la finestra Actions.

19.Selezionare Email dall'elenco Select type, quindi fare clic su Add.

20.Nel campo ActionTarget, digitare: customer@address.com

21.Fare clic su OK. 

La voce di scheda sarà simile a quella riportata di seguito:

22.Selezionare File > Salva progetto.

Aggiunta di un controllo CheckBox
CheckBox funge da controllo di attivazione/disattivazione così come una tipica casella di controllo.

Questa sezione utilizza il controllo Tab creato in precedenza.

1. Fare clic sulla scheda Approved: 

2. Trascinare il controllo CheckBox dal pannello di controllo e rilasciarlo sulla riga Approval: 

3. Nella griglia delle proprietà, eliminare CheckBox nel campo Caption e digitare Approved.

4. Aprire la finestra Screen Location utilizzando il pulsante acceleratore TextInsertionLocation.

5. Selezionare Location dall'elenco a discesa Select By.

6. Fare clic nel campo Status sulla riga Line Number, quindi fare clic su OK. Le coordinate 5,57
vengono visualizzate nel campo TextInsertionLocation.
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7. Nel campo TextToSend, digitare Approved.

8. Nel campo UnCheckedState > TextToSend, digitare Pending nel campo TextToSend. 

La griglia delle proprietà sarà simile a quella riportata di seguito:

La voce di scheda sarà simile a quella riportata di seguito:

9. Selezionare File > Salva progetto.

Aggiunta di un controllo MultiLine
Il controlloMultiLine è un campo di inserimento di testo con più righe nel quale l'utente digita un testo che
viene inserito in una posizione specifica della schermata. Ad esempio, il controllo MultiLine può essere
utilizzato per modernizzare o razionalizzare il layout di una schermata con campi di inserimento contenenti
più righe.

1. Trascinare il controllo MultiLine dalla griglia delle proprietà e rilasciarlo sull'area di lavoro vicino
all'etichetta Address.

2. Utilizzare gli angoli di ridimensionamento del controllo per estendere il controllo su due righe: 
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3. Aprire la finestra Screen Location utilizzando il pulsante acceleratore TextInsertionLocation.

4. Selezionare Location dall'elenco a discesa Select By.

5. Fare clic nel campo Address alla riga 7, colonna 16, quindi fare clic su OK.

6. Nel riquadro ColorSettings, selezionare Custom in Background, quindi fare clic sul pulsante giù 
per aprire la tavolozza dei colori Available Colors.

7. Selezionare RoyalBlue. 

Il colore riempirà il controllo MultiLine.

8. Selezionare Custom in Background, quindi selezionare White nella tavolozza dei colori Available
Colors. 

Questo sarà il colore del testo in modalità Plus.

9. Selezionare File > Salva progetto.

Pubblicazione online del progetto
Una volta completato il progetto di personalizzazione, è necessario:

• Creare un Archivio Plus.
• Associare l'archivio ad una sessione mainframe.
• Eseguire il test delle schermate.

Creazione di un archivio Plus
È necessario ora salvare tutti i controlli e le regole create in un Archivio Plus. L'archivio verrà poi collegato
ad una sessione mainframe.

Per generare l'archivio Plus:

1. Selezionare Crea > Archivio Plus. 

Viene visualizzata la finestra di dialogo Salva Archivio Plus.

2. Nel campo Nome file, digitare un nome per il file, come DemoHost.

3. Fare clic su Salva.
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4. Selezionare File > Esci.

Associazione dell'archivio Plus ad una sessione host
Il passaggio finale consiste nell'associare l'archivio Plus ad una sessione host. Per eseguire questa
operazione:

1. In Rumba+ Desktop, selezionare Plus > Plus Mode.

2. Selezionare Plus > Settings. 

Viene visualizzata la finestra di dialogo Configurazione sessione.

3. Nella pagina Plus, fare clic su Sfoglia accanto al campo Associa Plus archivio. 

Viene visualizzata la finestra di dialogo Associa archivio Plus.

4. Scegliere l'archivio Plus creato, quindi fare clic su Apri.

5. Nella finestra Configurazione sessione, fare clic su OK.

Esecuzione dei test delle schermate

1. Selezionare Connessione > Connetti.

La schermata mainframe viene visualizzata in modalità Plus con i controlli aggiunti:

2. Muovere il mouse sul pulsante Micro Focus. 

Viene visualizzato il testo della descrizione del comando che è stato creato:

3. Muovere il mouse su ENTER SYSTEM ID:

Viene visualizzato il testo della descrizione del comando che è stato creato:

4. Selezionare TSO MVS/XA dal controllo Chooser. L'azione AutoExecution specificata in AutoExecution
invia automaticamente un comando Enter per eseguire la selezione del sistema. Gli altri controlli
AutoExecution creati inviano automaticamente i comandi Enter ai prompt ENTER LOGON ID: eLAST
SYSTEM ACCESS, visualizzando la schermata del prompt READY, l'immagine aggiunta con il controllo
AutoExecution e la casella per il testo del messaggio creata:
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5. Procedere in uno dei modi seguenti:

• Fare clic su Cancel. Ciò consente di disconnettersi e sarà necessario avviare nuovamente la
sessione.

• Fare clic su OK per continuare.

6. Nel prompt READY, immettere: 

O

Viene visualizzata la SALES ORDER ENTRY CUSTOMER SCREEN:

Questa schermata contiene l'etichettaDate, e i controlli Calendar creati:
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7. Muovere il mouse sul controllo Calendar. 

Viene visualizzato il testo della descrizione del comando che è stato immesso:

8. Fare clic sul controllo Calendar. 

Viene visualizzato un calendario:

9. Selezionare la data di oggi. 

Viene visualizzata la data:

10.Fare clic all'interno del controllo MultiLine. Digitare un indirizzo scelto. Premere Alt+Enter per dividere
in due la riga. 

Il testo viene inserito sulla schermata verde, iniziando dalla posizione riga, colonna specificata nel
Screen Designer.

11.Premere PF3.

12.Nel prompt READY, immettere C. 

Viene visualizzata la schermata EUROPEAN CUSTOMER LIST insieme alla tabella creata con
GridCollector e i controlli GridCollector:
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13.Fare clic su Esporta in alto a destra nella tabella. 

Viene visualizzata la finestra di dialogo Salva con nome.

14.Specificare un nome per la tabella e fare clic su Salva. Il contenuto della tabella viene salvato in
formato .CSV.

15.Premere PF1.

16.Nel prompt READY, immettere: 

TOYS

17.Nella schermata TOPCO TOYS, INC, fare clic sul controllo WebFrame in JAN. 

Il grafico a torta che è stato creato viene visualizzato in una finestra separata:

18.Chiudere la finestra del grafico a torta.

19.Nella schermata TOPCO TOYS, INC, premere Enter.

20.Nel prompt READY, immettere: 

O

Viene visualizzata la SALES ORDER ENTRY CUSTOMER SCREEN:

21.Premere PF8. 

Viene visualizzata la SALES ORDER ENTRY DETAIL LINE ENTRY SCREEN con il controllo Tab che è
stato creato:

48 | Utilizzo del Screen Designer



22.Nella voce della scheda Order, nel campo Order Number, digitare 12345. 

Il numero viene visualizzato nel campo Order Number sulla schermata verde.

23.Selezionare il pulsante di opzione Open. 

Il testo Open viene visualizzato nel campo Status vicino al numero d'ordine:

24.Selezionare il pulsante di opzione Shipped. 

Il testo Shipped sostituisce Open nel campo Status:

Il client di posta elettronica predefinito apre una nuova finestra del messaggio per consentire di avvisare
il cliente che l'ordine è stato spedito.

25.Fare clic sulla scheda Quantity.

26.Nel campo Product Number, digitare ABC77701. 

Il testo viene visualizzato nel campo Product Number:

27.Nel campo Quantity, digitare 25. 

Il testo viene visualizzato nel campo Order Qty:

28.Fare clic sulla scheda Approved.

29.Selezionare Approved. 

La casella di controllo è deselezionata e il testo viene visualizzato Pending nel secondo campo
Status.

30.Selezionare nuovamente Approved. 

La casella di controllo è selezionata e il testo Approved viene visualizzato nel secondo campo
Status.

La schermata sarà simile a quella riportata di seguito:
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31.Selezionare Connessione > Disconnetti.
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Utilizzo del Rule Manager
Utilizzare Rule Manager per aggiungere controlli dinamici che si ripetono su più schermate o più volte su
una singola schermata.

Quando utilizzare Rule Manager
I seguenti scenari di base descrivono quando utilizzare Rule Manager invece della visualizzazione Screen
Design.

• Aggiunta di controlli Tooltip o Button ad intere applicazioni.

Campi con assistenza o controlli Tooltip speciali che rimangono coerenti all'interno dell'applicazione.
Utile particolarmente per spiegare le informazioni sull'account, sul cliente e sullo stato che vengono
abbreviate o visualizzate in forma abbreviata sulla schermata.

Pulsanti come Esci, Cancella (schermata) e Ripristina (tastiera).
• Aggiunta di controlli alle schermate all'interno di sottosistemi.

Controlli che sono coerenti con la maggior parte dei sottosistemi come contabilità fornitori, sistemi di
ticket di assistenza o ricerca di clienti. Un sottosistema può comprendere da cinque a dieci schermate,
ma le funzioni dell'operatore sono coerenti nell'intera applicazione.

Il contenuto della schermata può cambiare, ma le informazioni sull'intestazione devono offrire un simile
controllo della modernizzazione.

• I dati scorrono le aree con le modernizzazioni che si ripetono su ciascuna riga.

Una regola Plus può creare più modernizzazioni.

Suggerimento: Se si nota che un controllo nella visualizzazione Screen Design può essere
utilizzato meglio come regola, fare clic con il pulsante destro del mouse sul controllo e selezionare
Converti in regola dal menu a comparsa. Screen Designer sposta il controllo in Rule Manager.

La finestra Rule Manager
Per aprire la finestra Rule Manager, selezionare Tools > Rule Manager dalla barra degli strumenti di Rule
Manager.

Viene visualizzata la finestra Rule Manager:
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Pannello di controllo. Contiene l'elenco delle seguenti azioni:

Nuova regola Apre Rule Wizard per creare una nuova regola.

Modifica regola Apre la regola selezionata in Rule Wizard per modificarla.

Elimina regola Elimina la regola selezionata.

Abilita regola Abilita la regola selezionata, se disabilitata.

Disabilita regola Disabilita la regola selezionata.

Duplica regola Crea una copia della regola selezionata.

Il pannello di controllo contiene anche una casella di ricerca per cercare le regole.

Riquadro Elenco di regole. Contiene un elenco delle regole configurate. Ciascuna regola è
costituita da:

• Una descrizione.
•

Un'icona che utilizza la regola per filtrare le schermate .
• Un'icona per mostrare se la regola è abilitata 
•

Un'icona per mostrare se la regola è disabilitata 
•

Un'icona per modificare la regola 
•

Un'icona per eliminare la regola 

Riquadro Descrizione regola. Visualizza una versione della regola in linguaggio naturale.
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Creazione guidata delle regole
La creazione guidata delle regole consente di definire le regole e le condizioni che regolano il tipo di azioni
che si verificano su uno schermo e il momento in cui si verificano.

Riquadro Passaggi. Contiene i passaggi necessari per creare una regola. Il passaggio
corrente è evidenziato.

Riquadro Opzioni. Contiene le opzioni disponibili per la fase selezionata:

Quando questa fase è evidenziata ... Il riquadro Opzioni contiene...

Passaggio 1 Un elenco dei modelli che è possibile
utilizzare per creare una regola.

Passaggio 2 Condizioni che identificano la schermata a
cui verrà applicata la regola.

Passaggio 3 Campo, posizione o testo da cercare sulla
schermata.

Passaggio 4 Controlli da creare in base alle regole.

Passaggio 5 Eccezioni alle regole che selezionano le
schermate.

Riquadro Descrizione regola. Contiene una versione della regola in linguaggio naturale.
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Esempi
I seguenti esempi mostrano diversi modi in cui è possibile utilizzare Rule Manager per progettare
schermate più moderne.

Aggiunta di controlli Button o Button ad intere
applicazioni
Un pulsante di sistema semplice Clear viene progettato con una regola che lo posiziona su ogni
schermata dell'applicazione in alto a destra.

I controlli Button come questo aiutano gli utenti che non sono familiari alle regole relative alle applicazioni
3270/5250.

Aggiunta di controlli alle schermate all'interno di
sottosistemi
In questo esempio, l'amministratore desidera aiutare gli utenti ad identificare lo stato di un account. In
qualsiasi punto nell'applicazione in cui viene visualizzata la stringa ACCOUNT STATUS : AB, viene
visualizzata una descrizione del comando per informare l'operatore che lo stato dell'account è attivo con
credito approvato.

La regola trova prima la stringa di caratteri, quindi posiziona una descrizione del comando sull'intera
stringa. Spostando il mouse sul campo abbreviato, viene fornita una descrizione più dettagliata.
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Aggiunta di regole da utilizzare su una serie di
schermate
Questo esempio mostra tre schermate in un'applicazione denominata Master Inquiry. Le schermate sono
simili, ma presentano diverse richieste di input e intestazioni di dati. Ogni schermata viene identificata
automaticamente come una schermata diversa.

Nell'esempio, viene creata una regola che inserisce un pulsante Create New Customer vicino al primo
campo di immissione.

La regola per questo pulsante si basa sulla designazione della schermata Master Inquiry . Se la
schermata si identifica come Master Inquiry e viene trovata la stringa 5=display, la regola inserisce
automaticamente un pulsante accanto al campo 5=display. Nelle schermate che non corrispondono ai

Utilizzo del Rule Manager | 55



criteri specificati, non viene creato alcun pulsante. Il pulsante viene programmato con le sequenze di tasti
necessarie per creare un record cliente all'interno dell'applicazione.

Aggiunta di controlli ad ogni riga di una schermata
In questo esempio, vengono utilizzate schermate contenenti tabelle di dati e vengono aggiunti gli stessi
controlli a ciascuna riga visualizzata. Per utilizzare la visualizzazione Screen Design, è necessario
aggiungere un controllo separato per ciascuna riga di ogni tabella. In alternativa, è possibile usare le
regole per replicare i controlli su ciascuna riga.

Per selezionare un cliente, è necessario digitare 1, quindi premere Enter. Nell'esempio, viene impostata
una regola che sostituisce queste azioni.

Nota: Il numero delle voci di dati per pagina è soggetto a variazioni. La regola crea 10 selezioni
statiche per pagina. Di conseguenza, l'ultima pagina avrà solo tre pulsanti perché solo tre selezioni
sono valide.
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The rule looks for the character strings Select Customer and 1 Select. It then replaces the single
character input field with a button labeled SEL. This button replaces the two actions of typing 1 in the data
field and pressing Enter with a simple point and click.

Poiché la regola cerca il campo di inserimento, se non lo trova, il controllo non viene aggiunto alla
schermata.
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Utilizzo degli operandi nelle regole
In questo esempio, l'amministratore desidera identificare tutti i dipendenti che si sono uniti alla società dal
mese di marzo 2010 e guadagnano meno di 40.000 all'anno, per poi contrassegnare ogni schermata con
un'etichetta.

Questa regola prende in considerazione due schermate per le retribuzioni inferiori a 40.000 e le date
successive al 1 marzo 2010. Se vengono trovati entrambi i tipi di dati, sulla schermata viene posizionata
un'etichetta:

Utilizzo delle variabili nelle regole
In questo esempio viene utilizzata una variabile per visualizzare una casella per il testo del messaggio se
un valore supera un limite specificato. Se il saldo in attesa sulla schermata del conto di un cliente supera il
limite di 25, viene visualizzata una casella per il testo del messaggio per avvisare l'utente.

Un controllo Collector viene utilizzato per leggere il valore del campo appropriato:
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La regola prende in considerazione prima l'ID schermata corretto, quindi legge il valore della variabile
selezionata fornita dal controllo Collector.

Se il valore supera il limite di 25, viene visualizzata una casella per il testo del messaggio:
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Tipi di controllo

AutoExecution
AutoExecution viene usato per attivare una sequenza di azioni quando viene visualizzata una schermata
verde. Il controllo non è visibile in una sessione Plus.

Button
Button viene utilizzato per attivare una sequenza di azioni quando si fa clic su di esso. Il controllo può
contenere testo o un'immagine.

Proprietà:

Nome Impostazione predefinita Descrizione

Mode Testo Specifica il tipo di contenuto per il controllo. Può essere
Text o Image.

Nota: Se si seleziona Text, è possibile creare una
nuova riga o suddividere una riga esistente
premendo Alt+Invio.

ImagePath Stringa vuota Fare clic sul pulsante acceleratore per aprire la cartella
pool di immagini del progetto, in cui è possibile
selezionare un file immagine in formato JPG, GIF o
PNG. Per selezionare un'immagine diversa, fare clic su
Aggiungi al pool e sfogliare per cercare l'immagine da
utilizzare. Il file immagine viene quindi copiato nel pool di
immagini e salvato nel progetto.

In alternativa, è possibile immettere la posizione di
un'immagine sotto forma di percorso completo o indirizzo
Web completo nel campo ImagePath.

Disponibile solo se Mode è Image.

ImagePosition Stretch Specificare la posizione dell'immagine nel pulsante:

Stretch Predefinito.
Fill
Fit
Center

Calendar
Calendar viene utilizzato per scegliere una data e viene inizialmente mostrato sulla schermata come icona.
Calendar si apre quando si fa clic sull'icona. Si chiude quando perde lo stato attivo o quando viene
selezionata una data.

Quando viene selezionata una data in Selezione data, la data viene inserita sulla schermata nelle
coordinate definite da TextInsertionLocation. Il formato utilizzato è definito da InsertedDateFormat.
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Se il campo occupato da Calendar contiene date, il campo viene usato da Calendar quando viene aperto.
Altrimenti, Calendar utilizzerà la data corrente.

Nota: Se il controllo viene usato in una sessione Plus e se la posizione della schermata è un campo
protetto, è possibile visualizzare il calendario, ma non selezionare la data.

Proprietà:

Nome Impostazione predefinita Descrizione

InsertedDateFormat Stringa vuota Specifica il formato del testo che rappresenta il formato
della data.

Se vuoto, verrà utilizzato il formato data predefinito:

dd/MM/yyyy

Ad esempio, 03/01/2015.

Utilizzo della finestra di dialogo Formato data
Utilizzare la finestra di dialogo Formato data per selezionare un formato di data predefinito o per creare un
formato di data personalizzato.

Selezione dei formati della data
Per selezionare un formato di data diverso da quello predefinito:

1. Fare clic sul pulsante Acceleratore  vicino al campo InsertedDateFormat nella griglia delle proprietà.

Viene visualizzata la finestra di dialogo Formato data.

2. Selezionare un formato di data dall'elenco, quindi fare clic su OK. 

La finestra di dialogo verrà chiusa e viene visualizzato il formato di data scelto nel campo
InsertedDateFormat.

Utilizzo dei formati di data personalizzati
Per utilizzare un formato di data personalizzato:

1. Immettere il formato desiderato nel campo nella parte superiore della finestra di dialogo Formato data. 

Nota: Giorno e anno devono essere sempre specificati in minuscolo. Il mese deve essere sempre
specificato in maiuscolo.

2. Fare clic su Add. 

Il formato personalizzato viene visualizzato nell'elenco principale.

3. Fare clic su OK. 

La finestra di dialogo verrà chiusa e viene visualizzato il formato di data scelto nel campo
InsertedDateFormat.

4. Per rimuovere un formato personalizzato dall'elenco, selezionare il formato, quindi fare clic su Rimuovi. 

Nota: È possibile rimuovere soltanto i formati personalizzati, non quelli forniti.

Selezione del formato della data personalizzato
La tabella seguente descrive i formati della data utilizzabili nel controllo Calendar.
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Identificatore di formato Descrizione Esempio Interpretazione

g Rappresenta il numero di
sequenza di un giorno
nell'anno di calendario.

g visualizza valori tra 1, che
rappresenta il 1° gennaio, e
366, che rappresenta il 31
dicembre in un anno
bisestile.

g-aa

g-aaaa

La data 1/1/2015, g viene
visualizzata come 1-15.

La data 31/12/2015,

j viene visualizzata come
365-2015.

ggg Rappresenta il numero di
sequenza di un giorno
nell'anno di calendario.

ggg visualizza valori tra 1,
che rappresenta il 1°
gennaio, e 366, che
rappresenta il 31 dicembre
in un anno bisestile.

Per ggg, i valori minori di
100 vengono sostituiti da
uno zero iniziale o più zeri.

ggg-aa

ggg-aaaa

La data 1/1/2015, ggg
viene visualizzata come
001-15.

La data 31/12/2015, ggg
viene visualizzata come
365-2015.

d Il giorno del mese, dal 1° al
31.

M/g/aaaa

M/g/aa

Per la data 6/1/15, g viene
interpretato come 1.

Per la data 6/15/15, g viene
interpretato come 15.

gg Il giorno del mese, dal 1° al
31.

M/gg/aaaa

M/gg/aa

Per la data 6/1/2015

gg viene interpretato come
01.

Per la data: 6/15/15

gg viene interpretato come
15.

ggg Il nome abbreviato del
giorno della settimana.

M-ggg-aaaa

M-ggg-aa

Per la data 6-Lun-2015,
ggg viene interpretato
come Lun (per EN-US).

Per la data 6-lun.-15, ddd
viene interpretato come
lun. (per FR).

gggg Il nome intero del giorno
della settimana.

M-gggg-aaaa

M-gggg-aa

Per la data 6- Lunedì -2015

gggg viene interpretato
come lunedì (per EN-US).

Per la data 6- lunedì-15,
gggg viene interpretato
come lunedì (per FR).

M Il mese, dal 1° al 12. M-gg-aaaa Per la data 6/15/2015, M
viene interpretato come 6.

Per la data 12/15/2015, M
viene interpretato come 12.
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Identificatore di formato Descrizione Esempio Interpretazione

MM Il mese, dal 1° al 12. MM-gg-aaaa Per la data 06/15/2015, MM
viene interpretato come 06.

Per la data 12/15/2015, MM
viene interpretato come 12.

MMM Il nome abbreviato del
mese.

MMM-gg-aaaa Per la data Giu-15-2015,
MMM viene interpretato
come Giu (per EN-US).

Per la data giugno-15-2015,
MMM viene interpretato
come giugno (per FR).

MMMM Il nome intero del mese. MMMM-gg-aaaa Per la data
Gennaio-15-2015, MMMM
viene interpretato come
Gennaio (per EN-US).

y Rappresenta solo l'ultima
cifra dell'anno.

M-gg-a Per la data 2-03-15, a viene
interpretato come 5.

Quando il controllo
Calendar viene aperto
dall'utente, la cifra della
decade attuale viene
aggiunta a sinistra. Cioè,
l'anno viene impostato
come 15 (2015)

aa L'anno, da 00 a 99. M-gg-aa Per la data 6-15-15, aa
viene interpretato come 15.

aaaa L'anno, come numero di
quattro cifre.

M-gg-aaaa Per la data 6-15-2015, aaaa
viene interpretato come
2015.

Tutte le stringhe Separatori data. Esempi

M gg aaaa

M-gg-aaaa

M/gg/aaaa

M#aa#aaaa

CheckBox
Il controllo CheckBox funge da controllo di attivazione/disattivazione così come una tipica casella di
controllo.

CheckBox fornisce all'utente la scelta tra una o due opzioni, come Sì e No.

Nota: Se il controllo viene usato in una sessione Plus e se la posizione della schermata è un campo
protetto, il controllo viene disabilitato.

Proprietà:
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Nome Impostazione predefinita Descrizione

CheckedState Stringa vuota Il testo da utilizzare nella posizione specificata della
schermata e qualsiasi azione specificata da eseguire se
la casella di controllo è selezionata.

UnCheckedState Stringa vuota Il testo da utilizzare nella posizione specifica della
schermata e qualsiasi azione specificata da eseguire se
la casella di controllo è deselezionata.

Chooser
Chooser viene visualizzato sulla schermata come controllo a discesa. Chooser viene utilizzato per inserire
dati nel campo sulla schermata selezionando una voce dall'elenco.

Il completamento automatico è supportato.

Nota: Se il controllo viene usato in una sessione Plus e se la posizione della schermata è un campo
protetto, il controllo viene disabilitato.

Proprietà:

Nome Impostazione predefinita Descrizione

IsAutoCompleteEnabled Selezionato Se selezionata, Chooser offre automaticamente una voce
corrispondente senza distinzione tra lettere maiuscole e
minuscole da selezionare dall'elenco. Se l'utente non
scrive nel campo di schermata occupato da Chooser, non
viene visualizzato alcun suggerimento.

IsEditable Selezionato Se selezionata, i dati possono essere scritti nel campo
che Chooser sta utilizzando. Se deselezionata, i dati
possono essere selezionati solo dall'elenco a discesa.

UseDynamicData Deselezionata Se selezionata, l'elenco delle voci viene preso in modo
dinamico da un file .CSV. Il file .CSV può essere un file
locale o di rete oppure un URI.

ChooserItems Elenco vuoto L'elenco di voci visualizzate nell'elenco a discesa quando
si fa clic sulla freccia giù. L'elenco delle voci può essere
importato da un file .CSV (vedere di seguito). Ogni voce
è specificata da Caption, Tooltip e ValueToInsert. Se è
selezionata la voce UseDynamicData, il campo
ChooserItems conterrà il percorso completo del
file .CSV o verrà aperta una finestra di dialogo per
consentire di selezionarlo.

ValueToInsert Specifica il testo da inserire quando si seleziona una
voce dall'elenco.

Utilizzo di un file .CSV per la fornitura dei dati
Se viene selezionato UseDynamicData, l'elenco di ChooserItems viene preso da un file .CSV. Il file può
essere locale o di rete oppure un URI. Il campo ChooserItems contiene il percorso completo del file .CSV,
che è possibile selezionare facendo clic sul pulsante acceleratore.

Per utilizzare correttamente questa funzione, i contenuti del file .CSV devono essere nel seguente formato:

<CAP><DEL><TIP><DEL><VAL>

dove:
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Questo... Indica questo...

<CAP> Didascalia.

<DEL> Delimitatore (;). Questo è l'unico delimitatore supportato.

<TIP> Descrizione comando.

<VAL> Valore da inserire.

Esempio:

#First block

AAA;BBB;CCC

DDD;EEE;FFF

GGG;HHH;III

JJJ;KKK;LLL

MMM;NNN;OOO

Caricamento dei dati da un file .CSV:

1. Selezionare UseDynamicData nella griglia delle proprietà.

2. Fare clic sul pulsante acceleratore vicino al campo ChooserItems.

3. Nella finestra di dialogo Apri, trovare il file .CSVChooserItems e selezionarlo.

4. Fare clic su Apri.

Importazione di un file .CSV:

1. Lasciare UseDynamicData deselezionato.
2. Fare clic sul pulsante Acceleratore vicino a ChooserItems nella griglia delle proprietà.
3. Nella finestra di dialogo ChooserItems, fare clic sull'icona Importa.
4. Selezionare il file .CSV.
5. Fare clic su OK.

Caricamento dinamico dei dati in una sessione Plus
È possibile utilizzare un URI per fornire dati da un'origine remota a un controllo durante una sessione
Chooser. L'origine può essere un file .CSV o un servizio Web che restituisce un output con formato .CSV.

Il contenuto del viene caricato dinamicamente e inserito nella cartella del progetto ogni volta che viene
visualizzata la schermata contenente Chooser.

1. Selezionare UseDynamicData nella griglia delle proprietà.

2. Nel campo ChooserItems, digitare l'URI dell'origine dati. Esempio: 

http://www.<domain>.com/<service_name>?<parameter>=<value>

Nota: Se l'URI non è accessibile per un motivo qualsiasi, vengono utilizzati i dati inseriti.

Collector
Collector non è visibile in una sessione Plus. Viene usato per copiare il testo dalla posizione della
schermata del Collector al database della sessione. La posizione della schermata del Collector è definita
da due coppie (Row Offset, Column Offset), (Row Span, Column Span).

La durata del database è l'intera sessione. I dati vengono raccolti quando appare la schermata host come
un elenco di coppie (chiave, valore) di stringhe. I dati possono essere utilizzati da altri controlli solo dalla
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sessione corrente. Quando la posizione della schermata del Collector è segmentata sulle righe della
schermata, vengono inserite appropriate interruzioni di riga nei dati raccolti.

Per esempio, un controllo Button che ha l'aspetto di un'icona di una cornetta può essere impostato come
azione Run_Application per avviare Skype. Additional_Arguments di quest'azione può utilizzare un
numero di telefono memorizzato dal Collector contenuto in un campo del numero di telefono su un'altra
schermata della sessione.

Proprietà:

Nome Impostazione predefinita Descrizione

TrimSpaces Selezionato Se è selezionata, tutti gli spazi iniziali e finali non
vengono copiati nel database. Se non è selezionata, gli
spazi sono inclusi nei dati.

Nota: La proprietà Name specifica anche una chiave che un controllo Collector deve utilizzare
durante la copia dei dati dalla posizione della schermata di Collector nel database.

Dati salvati con la stessa chiave più di una volta vengono sovrascritti.

In seguito è possibile accedere ai dati nella sessione utilizzando la sintassi:

%%PhoneNumber%%

dove PhoneNumber è il nome della variabile globale.

GridCollector
Il controllo GridCollector è una versione estesa del controllo Collector. Collector raccoglie dati in forma di
testo da una posizione specifica della schermata. GridCollector raccoglie dati in forma di tabella (griglia).

Il controllo memorizza le informazioni raccolte in un database per l'intera durata della sessione corrente.
L'informazione può essere utilizzata da qualsiasi altro controllo.

Per configurare le proprietà GridCollector, fare clic sul pulsante Modalità modifica nell'angolo in alto a
destra del controllo. Al termine, fare clic sul pulsante Salva ed esci oppure sul pulsante Annulla modalità
modifica.

Proprietà:

Nome Impostazione predefinita Descrizione

Columns GridCollector Column Insieme di colonne. Ogni colonna ha una proprietà.

Nome: Stringa non vuota.

IncludesHeader Selezionato Se selezionata, la selezione include il titolo della tabella.

AvoidDuplications Selezionato Se selezionata, le righe duplicate non vengono raccolte.

MultiPageNavigation Selezionato Se selezionata, le seguenti proprietà vengono attivate:

MaxPagesToLookUp
ForwardNavigation
BackwardNavigation

MaxPagesToLookUp 1 Numero intero. Il numero di pagine aggiuntive recuperate
in anticipo ogni volta che viene attivata l'operazione di
recupero da uno dei controlli che utilizza i dati
GridCollector. GridCollector implementa il meccanismo di
recupero (non il controllo che utilizza GridCollector).

ForwardNavigation
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Nome Impostazione predefinita Descrizione

AidKey PF8 Il tasto di AIUTO per recuperare la pagina successiva.

EndOfDataConditions Facendo clic sul tasto acceleratore, viene aperta la
finestra di dialogo EndOfDataConditions.

BackwardNavigation

AidKey PF7 Il tasto di AIUTO per recuperare la pagina precedente.

EndOfDataConditions Facendo clic sul tasto acceleratore, viene aperta la
finestra di dialogo EndOfDataConditions.

SaveCommand Esegue un'azione o un insieme di azioni una volta fatto
clic sul pulsante Salva nella tabella collegata. Facendo
clic sul pulsante acceleratore, viene aperta la finestra di
dialogo SaveCommand, in cui è possibile specificare le
azioni da eseguire.

Aggiornamento dei dati
Se è stata specificata un'azione da eseguire in una tabella e tale azione è relativa ad una riga, potrebbe
essere richiesto un aggiornamento per sincronizzare i dati della tabella con i dati raccolti dalla schermata
verde. Per specificare un aggiornamento, è possibile comandare al controllo GridCollector associato di
ritornare alla schermata della prima tabella e raccogliere nuovamente i dati. Per eseguire questa
operazione:

1. Fare clic sull'icona Modifica sul controllo GridCollector.

2. Nella griglia delle proprietà, in BackwardNavigation, selezionare un tasto PF dall'elencoAidKey da
usare come tasto di AIUTO. Il valore predefinito è PF7

3. In BackwardNavigation, fare clic sul pulsante acceleratore vicino al campo EndOfDataConditions. 

Viene visualizzata la finestra di dialogo EndOfDataConditions.

4. Dall'elenco Seleziona tipo, selezionare la condizione di interruzione per determinare la prima pagina
della tabella, quindi fare clic su Aggiungi. La condizione predefinita è Timeout.

5. Fare clic su OK. 

Proprietà EndOfDataConditions
Nome Impostazione predefinita Descrizione

Timeout Se selezionata, la raccolta dei dati viene interrotta se non
si riceve una risposta nell'intervallo specificato dal valore
WaitForResponseTimeout.

WaitForResponseTimeout 2000 Timeout, in millisecondi. Il valore minimo è 500 ms. Il
valore massimo è 10000 ms.

EmptyLine Se selezionata, la raccolta di dati viene interrotta appena
viene trovata una riga vuota.

Text Se selezionata, la raccolta di dati viene interrotta in questi
casi:

La stringa non vuota specificata si trova nella posizione
della schermata specificata.

o:
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Nome Impostazione predefinita Descrizione

La stringa specificata è vuota e non viene trovato niente
nella posizione della schermata specificata.

EndOfDataText Testo da cercare. Disponibile se viene selezionato Testo.

EndOfDataTextLocation Ovunque Posizione del testo. Una delle seguenti:

• L'intera schermata, come specificato nella stringa
Ovunque.

• Una posizione specifica sulla schermata, specificata
nella finestra di dialogo Posizione della schermata.
Per aprire la finestra di dialogo, fare clic sul pulsante
Acceleratore vicino al campo
EndOfDataTextLocation.

EndOfDataTextRow Riga del testo.

EndOfDataTextColumn Colonna del testo.

Nota: GridCollector controlla le condizioni di interruzione dall'alto verso il basso dell'elenco finché
ogni condizione viene soddisfatta, quindi interrompe la raccolta dei dati. In questo modo, è possibile
riordinare le condizioni per raccogliere diverse quantità di dati dalle stesse schermate.

Sintassi
Qualsiasi controllo che voglia utilizzare i dati da GridCollector può ottenere i dati utilizzando la seguente
sintassi:

%%GridCollector_Name[Row_Number,Column_Name]%%

Esempi

%%Customers[5,Address]%% Definisce la ricerca dell'indirizzo della voce 5.

%%Customers[*,Address]%% Definisce la ricerca dell'indirizzo di tutti i clienti. Questo
può essere utile per impostare un'origine di elenco degli
elementi di controllo.

%%Customers[3,*]%% Definisce la ricerca di tutti i dati per il cliente nella terza
riga.

%%Customers[*,*]%% Definisce la ricerca dei dati GridCollector per tutti i clienti.

Su una schermata Plus, ogni volta che appaiono nuovi dati, questi vengono aggiunti alla tabella
GridCollector.

Image
Il controlloImage viene utilizzato per nascondere un'area della schermata. Il controllo viene visualizzato in
una sessione Plus senza un frame e può essere riempito con una delle seguenti opzioni:

Image Se viene selezionata un'immagine valida, o fornito un URL valido, il controllo Image è invisibile
sulla schermata.

Color È possibile usare il colore dello sfondo host come colore di riempimento (valore predefinito) o
selezionare un colore personalizzato dalla tavolozza dei colori. Il colore predefinito è nero. Se
viene selezionato un riempimento trasparente, il controllo Image è invisibile sulla schermata.
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È possibile modificare l'opacità del controllo Image per mostrare i contenuti della schermata dietro il
controllo. Per effettuare questa operazione, selezionare il controllo, quindi fare clic sull'icona nell'angolo in
alto a destra del frame del controllo.

Proprietà:

Nome Impostazione predefinita Descrizione

Tipo Immagine Tipo di riempimento. Può essere Image o Color.

ImagePath Stringa vuota Fare clic sul pulsante acceleratore per aprire la cartella
pool di immagini del progetto, in cui è possibile
selezionare un file immagine in formato JPG, GIF o
PNG. Per selezionare un'immagine diversa, fare clic su
Aggiungi al pool e sfogliare per cercare l'immagine da
utilizzare. Il file immagine viene quindi copiato nel pool di
immagini e salvato nel progetto.

In alternativa, è possibile immettere la posizione di
un'immagine sotto forma di percorso completo o indirizzo
Web completo nel campo ImagePath.

Disponibile solo se Type è Image.

ImagePosition Stretch Posizione e dimensione dell'immagine selezionata. Può
essere una delle seguenti opzioni:

Stretch Predefinito.
Fill
Fit
Tile
Center

Disponibile solo se Type è Image.

ColorSettings Disponibile solo se Type è Color.

Sfondo Nero Specifica il colore di riempimento del controllo. Può
essere:

• FromHost: viene usato il colore dello sfondo host.
• Personalizzato: è possibile selezionare un colore

dalla tavolozza dei colori.

InputField
Il controllo InputField fornisce un campo di inserimento di testo nel quale l'utente digita un testo che viene
aggiunto in una posizione specifica della schermata.

Per esempio, InputField può essere utilizzato per modernizzare o razionalizzare il layout di una schermata
con un numero di campi di inserimento. I controlliInputField possono essere posizionati dove sono più utili.
Le informazioni immesse dall'utente vengono poi aggiunte nelle posizioni della schermata nelle aree
modificabili tradizionali.

Nota: Quando il controllo viene utilizzato in una schermata Plus, nel campo di inserimento viene
visualizzato il valore dalla posizione della schermata, alla lunghezza specificata. Tuttavia, se la
posizione della schermata è un campo protetto, non è permessa alcuna digitazione nel controllo
InputField.

Inoltre, se la lunghezza è 0 (impostazione predefinita), i dati vengono letti fino alla fine del campo
della schermata verde al quale il controllo si riferisce, e il numero dei caratteri viene limitato dalla
lunghezza della schermata verde.
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Proprietà:

Nome Impostazione predefinita Descrizione

IsEnabled Selezionato Specifica se il controllo consente o meno l'input
dell'utente.

IsNumeric Deselezionata Specifica se l'input è numerico e non per tutti i caratteri.

IsPassword Deselezionata Quando è selezionata, viene visualizzato un carattere
maschera (*) invece dei caratteri digitati.

Length 0 Il numero massimo di caratteri che il campo di input può
contenere. Un valore di 0 indica che il numero dei
caratteri è limitato dalla lunghezza del campo della
schermata verde.

AutoTab Deselezionata Quando è selezionata e la lunghezza del testo inserito
coincide con quella del campo di inserimento di testo, il
cursore si sposta automaticamente nel controllo del
campo successivo, come definito dalla proprietà
TabOrder .

Utilizzo del completamento automatico
La funzionalità di completamento automatico tenta di prevedere ciò che si desidera digitare in un campo
non protetto in una schermata verde o in un controllo InputField in una sessione Plus. I suggerimenti sono
basati sulle voci che sono state precedentemente digitate nel campo o nel controllo.

Quando si inizia a digitare, viene visualizzato un elenco popup che offre una serie di suggerimenti.

A questo punto è possibile eseguire una delle seguenti operazioni:

• Selezionare un suggerimento dall'elenco popup.
• Eliminare un suggerimento selezionando X a destra del suggerimento.
• Ignorare tutti i suggerimenti e continuare a digitare.

Per ulteriori informazioni, vedere la guida Rumba+ Desktop.

Label
Il controllo Label è un controllo di riga singola utilizzato per posizionare un testo statico in una posizione
specificata della schermata.

Proprietà:

Nome Impostazione predefinita Descrizione

HostText Selezionato Se selezionata, il testo host posizionato in (StartRow,
StartColumn) viene utilizzato come testo etichetta. Se
deselezionata, LabelText è disponibile.

LabelText Label Se HostText è deselezionata, questo specifica il testo
personalizzato da mostrare sull'etichetta.

Nota: È possibile creare una nuova riga o
suddividere una riga esistente premendo Alt
+Invio.

TranslateText Deselezionata Se selezionata, il testo dell'etichetta viene tradotto
utilizzando il file della lingua specificato nella finestra
Impostazioni progetto.
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Nome Impostazione predefinita Descrizione

TextLocation InPlace La (riga, colonna) in cui il testo etichetta deve essere
acquisito sulla schermata. InPlace indica che il testo
etichetta deve essere acquisito dalla posizione del
controllo per come specificato nella visualizzazione
Screen Design, oppure dalla posizione dell'indicatore
logico definita dalla condizione SearchFor.

La posizione sulla schermata può essere definita anche
dall'utilizzo della finestra Selezionare la posizione della
schermata, che viene aperta facendo clic sul pulsante
Acceleratore vicino al campo TextLocation.

TextLength 0 Specifica il numero di caratteri nel testo etichetta.

Alignment Left Specifica l'allineamento del testo etichetta:

Left
Center
Right

Traduzione del testo del controllo Label
È possibile specificare l'opzione per tradurre in un'altra lingua il testo di specifici controlli Label. Per
effettuare questa operazione, è necessario creare un file di risorse di traduzione, ossia un file .csv
contenente stringhe delimitate da punti e virgola. È possibile quindi configurare i controlli Label.

Configurazione della traduzione del controllo Label

1. Creare un file di risorse di traduzione nel seguente formato: 

<source_language_phrase>; <target_language_phrase>

<source_language_phrase>; <target_language_phrase>

<source_language_phrase>; <target_language_phrase>

<source_language_phrase>; <target_language_phrase>

<source_language_phrase; <target_language_phrase>

2. Salvare il file in formato .csv.

3. Selezionare Strumenti > Impostazioni progetto. 

Viene visualizzata la finestra Impostazioni progetto.

4. Selezionare Traduzione nel riquadro a sinistra.

5. Fare clic su Sfoglia accanto al campo File di traduzione. 

Viene visualizzata la finestra Seleziona file di traduzione.

6. Selezionare il file appropriato e fare clic su Apri. 

Nota: È possibile anche digitare un URI nel campo File di traduzione. L'URI può contenere
parametri, come le credenziali di accesso. Esempio:

https://<user_id>:<password>@www.<domain>.com

Dati forniti a discrezione dell'utente. Non si garantisce la sicurezza della transazione.

7. Opzionale: Selezionare Traduci controlli Label creati.

8. Fare clic su OK.

Abilitazione della traduzione del controllo Label

1. Selezionare ciascun controllo Label in Screen Designer.
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2. Selezionare TranslateText nella griglia delle proprietà.

MultiLine
Il controlloMultiLine è un campo di inserimento di testo con più righe nel quale l'utente digita un testo che
viene inserito in una posizione specifica della schermata.

Ad esempio, il controllo MultiLine può essere utilizzato per modernizzare o razionalizzare il layout di una
schermata con campi di inserimento contenenti più righe. I controlli possono essere posizionati dove sono
più utili. Le informazioni digitate dall'utente vengono poi inserite nelle posizioni della schermata nelle aree
modificabili tradizionali.

Quando si digita un testo in un controllo MultiLine, il testo ritorna a capo automaticamente. Per inserire una
nuova riga, premere Alt+Invio.

Se il controllo viene utilizzato in una sessione Plus, viene visualizzato il valore della posizione della
schermata, alla lunghezza specificata. Tuttavia, se la posizione della schermata è un campo protetto, non è
permessa alcuna digitazione nel controllo InputField.

Proprietà:

Nome Impostazione predefinita Descrizione

IsEnabled Selezionato Specifica se il controllo consente o meno l'input
dell'utente.

IsNumeric Deselezionata Specifica se l'input è numerico e non per tutti i caratteri.

Length 0 Il numero massimo di caratteri che il campo di input può
contenere. Un valore di 0 indica che il numero dei
caratteri è limitato dalla lunghezza del campo della
schermata verde.

Nota: La proprietà IsPassword non è disponibile per il controllo MultiLine. Se è richiesto il controllo
della password, è necessario usare il controllo InputField.

MessageBox
Il controllo MessageBox è una casella per il messaggio di avviso che può essere configurata con un titolo,
un'icona, da uno a tre pulsanti e un messaggio.

I controlli MessageBox possono risultare particolarmente utili se una schermata verde genera un
messaggio, pur essendo coperta con un'area di disegno. In questo caso, non è possibile vedere il
messaggio. Questo problema viene risolto utilizzando un controllo MessageBox.

Proprietà:

Nome Impostazione predefinita Descrizione

Titolo Titolo Il titolo della casella per il testo del messaggio. Conforme
a Collector.

Testo Messaggio Il messaggio da visualizzare nella casella per il testo del
messaggio. Conforme a Collector.

Nota: È possibile creare una nuova riga o
suddividere una riga esistente premendo Alt
+Invio.

IconPath Warning.png Fare clic sul pulsante acceleratore per aprire la cartella
pool di immagini del progetto, in cui è possibile
selezionare un file immagine in formato JPG, GIF o
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Nome Impostazione predefinita Descrizione

PNG. Per selezionare un'immagine diversa, fare clic su
Aggiungi al pool e sfogliare per cercare l'immagine da
utilizzare. Il file immagine viene quindi copiato nel pool di
immagini e salvato nel progetto.

Vengono forniti quattro file immagine:

Error.png

Question.png

Warning.png

Information.png

Pulsante

IsVisible Selezionato

Deselezionata

Selezionato

Se selezionato, il pulsante viene visualizzato nella casella
per il testo del messaggio.

Caption OK

Stringa vuota

Annulla

Il testo da visualizzare nella casella per il testo del
messaggio. Conforme a Collector.

Azioni Elenco vuoto Una o più azioni da eseguire in sequenza dall'alto verso il
basso nell'elenco specificato nella finestra di dialogo
Azioni.

RadioButton
Il controllo RadioButton viene utilizzato per aggiungere testo in una posizione specifica della schermata.

Nota: Se il controllo viene usato in una sessione Plus e se la posizione della schermata è un campo
protetto, il controllo viene disabilitato.

Proprietà:

Nome Impostazione predefinita Descrizione

GroupName Stringa vuota Il gruppo dei pulsanti di opzione al quale questo pulsante
di opzione appartiene.

SelectedState Stringa vuota Il testo da utilizzare nella posizione specificata della
schermata e qualsiasi azione specificata da eseguire se
la casella di controllo è selezionata.

UnselectedState Stringa vuota Il testo da utilizzare nella posizione specificata della
schermata e qualsiasi azione specificata da eseguire se il
controllo non è selezionato.

Tab
fornisce un'area della schermata alla quale assegnare altri controlli. È possibile avere più controlli Tab su
una schermata, con più voci di scheda all'interno di un controllo Tab.

Per assegnare un controllo ad una voce di scheda, trascinare il controllo nell'appropriata voce della
scheda.

Quando viene selezionata un'altra voce di scheda, viene visualizzata insieme ai suoi controlli.
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Notes:

• Eliminare una voce di scheda significa eliminare tutti i controlli ad essa assegnati.
• Eliminare un controllo Tab significa eliminare tutte le voci di scheda e i controlli ad essa assegnati.

Proprietà:

Nome Impostazione predefinita Descrizione

TabItems Raccolta vuota Elenca tutte le voci di scheda e i loro controlli. Tutte le
voci di scheda hanno una didascalia.

HeaderWidth Statico Specifica la larghezza dei titoli della voce di scheda.
Statico imposta una larghezza fissa specificata da
HeaderSize. Dinamico imposta una larghezza variabile
in accordo con la lunghezza del titolo del testo.

HeaderSize 8 Specifica la larghezza fissa dei titoli della voce di scheda.

ColorSettings

Sfondo Specifica il colore utilizzato per lo sfondo del controllo.
Può essere:

• FromHost: viene usato il colore dello sfondo host.
• Personalizzato: è possibile selezionare un colore

dalla tavolozza dei colori.

Table
I dati dei formati del controllo Table da più schermate in una tabella a scorrimento con funzionalità di
filtraggio e ordinamento.

Il controllo Table utilizza un controllo predefinito GridCollector come fonte dati. Se c'è già un GridCollector
sulla schermata, il controllo Table si collega ad esso automaticamente. Se non ci sono GridCollector sulla
schermata, è necessario collegarlo a un GridCollector manualmente utilizzando la proprietà
LinkedGridCollectorName.

Proprietà:

Nome Impostazione predefinita Descrizione

LinkedGridCollect
orName

GridCollector1 Nome del controllo GridCollector al quale il controllo
Table è collegato.

Columns Serie di colonne.

Title Nome della colonna GridCollector
collegata.

Titolo visibile della colonna.

IsVisible Selezionato Se selezionata, la colonna diventa visibile su una
schermata Plus.

ColumnAlignment Left Allinea il testo della cella. Può essere una delle
seguenti opzioni:

Left
Center
Right

ColumnAliasInGri
dCollector

Nome della colonna GridCollector dalla quale
vengono presi i dati.

ContentSettings

Tipo di dati String Può essere una delle seguenti opzioni:
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Nome Impostazione predefinita Descrizione

String
Number
Date

Tipo di controllo None I controlli riportati di seguito vengono usati per
specificare nuovi valori nelle celle della tabella. Può
essere una delle seguenti opzioni:

None
TextBox
CheckBox
RadioButton
Calendar
Combo

Per ulteriori impostazioni, fare clic sul tasto
acceleratore accanto al controllo selezionato.

Notes:

• TextBox TextBox specifica una casella di
testo standard. Non sono disponibili altre
impostazioni.

• Combo Il funzionamento del controllo
Combo è simile a quello del controllo
Chooser.

IsHeaderVisible Deselezionata Se selezionata, la tabella mostra i titoli delle colonne.

IsFilterable Selezionato Se selezionata, aggiunge un campo Filter alla
tabella. Il valore inserito esclude tutte le righe eccetto
quelle con stringhe o un prefisso di stringa che
corrisponde al filtraggio testo in una colonna.

IsMoreButtonVisi
ble

Selezionato Se selezionata, aggiunge un pulsante Esporta alla
barra del titolo della tabella. More scorre in basso la
schermata finché non trova più dati della tabella.

IsAutoNavigateOn
Load

Selezionato Se selezionata, il controllo Table attiva il GridCollector
per recuperare le pagine seguenti in modo
automatico quando il controllo Table viene attivato.

IsExportButtonVis
ible

Deselezionata Se selezionata, aggiunge un pulsante Esporta alla
barra del titolo della tabella. Ciò consente all'utente di
esportare i contenuti della tabella in un file .csv
delimitato da virgola per un utilizzo in Microsoft Excel.

DefaultRowComm
and

InPlace Consente di specificare una o più azioni da eseguire
quando si fa doppio clic su una riga. Quando
vengono create azioni, la seguente sintassi può
essere utilizzata per prendere il testo da qualsiasi
cella di tabella in una riga sulla quale viene fatto
doppio clic:

##ColumnAliasInGridCollector##

Anche la seguente sintassi può essere utilizzata per
prendere testo da qualsiasi controllo Collector:

%%GlobalVariableName%%

Se il valore del controllo DefaultRowCommand è
impostato su uno dei controlli ClearField,SetCursor
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Nome Impostazione predefinita Descrizione

o SetText, è possibile impostare il controllo
TextInsertionLocation su:

InPlace: indica la posizione del controllo come
specificato nella visualizzazione Screen Design o la
posizione dell'indicatore logico definita dalla
condizione SearchFor.

o:

Relative: indica la posizione dell'azione da eseguire
relativa alla posizione della riga su cui si è fatto clic
nel controllo GridCollector collegato, tenendo
presente l'offset (riga, colonna) specificato. Vedere le
note di seguito.

Notes:

• Se il valore TextInsertionLocation èRelative, la navigazione in avanti o all'indietro potrebbe
essere attivata sulla schermata verde. In tal caso, se la riga di destinazione non si trova più nella
posizione prevista, il controllo GridCollector collegato aggiorna i dati per risincronizzare i dati della
tabella con i dati raccolti dalla schermata verde.

• I valori dell'offset (riga, colonna) vengono aggiunti alla posizione (riga, colonna) del record
selezionato all'estrema sinistra, come rappresentato nel controllo GridCollector collegato.

Modifica dei dati della tabella in modalità Plus

Per riuscire a modificare i dati della tabella, è necessario aggiungere i controlli alla tabella mediante le
impostazioni Tipo di controllo.

Per modificare i dati in modalità Plus:

1. Utilizzare i controlli della tabella per modificare i dati.
2. Fare clic su Salva.

La tabella passa alle pagine contenenti le righe modificate e aggiorna i valori sulla schermata verde. Una
volta completati gli aggiornamenti, viene eseguita l'azione GridCollectorSaveCommand. In tal modo,
vengono salvate le modifiche all'applicazione della schermata verde.

Tooltip
Il controllo Tooltip viene attivato al passaggio del mouse sull'area di schermata occupata da Tooltip.

Esistono due modalità per Tooltip:

Modalità statica Il contenuto di Tooltip è una stringa libera. La stringa può includere parametri globali
impostati dagli agenti di raccolta.

Modalità avanzata Tooltip può leggere il testo da una posizione della schermata e utilizzarlo come testo
visualizzato.

Proprietà:

Nome Impostazione predefinita Descrizione

Caption Stringa vuota Specifica il testo che viene visualizzato da Tooltip. I dati
salvati da controlli Collector possono essere utilizzati.

Advanced Deselezionata Se selezionata, attiva la modalità avanzata.
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KeyTextLocation InPlace La (riga, colonna) in cui il testo deve essere acquisito
dalla schermata. InPlace indica la posizione del controllo
come specificato nella visualizzazione Screen Design o
la posizione dell'indicatore logico definita dalla condizione
SearchFor.

La posizione della schermata può essere definita dall'uso
della finestra Selezionare la posizione della
schermata, che viene aperta facendo clic sul pulsante
Acceleratore vicino al campo KeyTextLocation. Solo
modalità avanzata.

TooltipItems Specifica un elenco di elementi che verranno visualizzati
dal controllo Tooltip. Solo modalità avanzata.

Key: la stringa sulla schermata host sotto cui verrà
visualizzata la didascalia Tooltip.
Caption: il testo da visualizzare nel controllo Tooltip.
È possibile utilizzare anche i dati memorizzati
mediante i controlli Collector. Premere Alt+Invio per
aggiungere una nuova riga.

Importazione di elementi da un file .csv

Per utilizzare correttamente questa funzione, i contenuti del file .csv devono essere nel seguente formato:

<KEY><DEL><TIP>

dove:

Questo... Indica questo...

<KEY> Chiave che rappresenta testo di emulazione su schermata.

<DEL> Delimitatore (;). Questo è l'unico delimitatore supportato.

<TIP> Testo descrizione di comando.

Esempio:

#Tool Tip values

TSO;TSO log on

Password;Enter your password

Application required;Enter your CICS application name

Userid;Enter your user ID

Per importare un file .csv:

1. Fare clic sul pulsante Acceleratore vicino a TooltipItems nella griglia delle proprietà.
2. Nella finestra di dialogo TooltipItems, fare clic sull'icona Importa.
3. Selezionare il file .csv.
4. Fare clic su OK.

WebFrame
WebFrame è un controllo che può essere visualizzato come icona o come finestra incorporata sulla
schermata. Un'icona di un piccolo globo può essere impostata per aprire una mappa in base all'indirizzo
postale visualizzato nel campo della schermata host. In una finestra incorporata viene visualizzato il
contenuto in uno specifico indirizzo web quando arriva la schermata.
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Proprietà:

Nome Impostazione predefinita Descrizione

Modalità Popup Specifica se WebFrame viene visualizzato come icona
(Popup) o come finestra incorporata (Incorporata).

ImagePath Stringa vuota Fare clic sul pulsante acceleratore per aprire la cartella
pool di immagini del progetto, in cui è possibile
selezionare un file immagine in formato JPG, GIF o
PNG. Per selezionare un'immagine diversa, fare clic su
Aggiungi al pool e sfogliare per cercare l'immagine da
utilizzare. Il file immagine viene quindi copiato nel pool di
immagini e salvato nel progetto.

In alternativa, è possibile immettere la posizione di
un'immagine sotto forma di percorso completo o indirizzo
Web completo nel campo ImagePath.

Disponibile solo se la modalità è impostata su Popup.

URLSource Stringa vuota Qualsiasi indirizzo Web valido. I dati memorizzati
mediante i controlli Collector possono essere utilizzati per
specificare la destinazione.

Width 500 Larghezza della finestra in pixel.

Height 500 Altezza della finestra in pixel.

Proprietà condivise
Ognuna delle seguenti proprietà può essere utilizzata da più di un tipo di controllo:

Nome Impostazione predefinita Descrizione

Nome Specifica un nome personalizzato per il controllo.

Nota: Se una regola crea più di un controllo dello
stesso tipo nella stessa schermata, la seguente
convenzione di denominazione viene utilizzata:

<name>, <name>_1, ...
<name>_<name>

Caption Nome del controllo Il testo da visualizzare nel controllo. È possibile applicare
al testo il grassetto, il corsivo o il sottolineato nella
sessione Style della griglia delle proprietà.

IsVisible Selezionato Se selezionato, il controllo diventa visibile su una
schermata Plus.

Tooltip Stringa vuota Il testo della descrizione comando viene mostrata al
passaggio del mouse. Se vuoto, non verrà visualizzata
nessuna descrizione comando.

TextInsertionLocation InPlace La (riga, colonna) nella quale viene inserito un testo sulla
schermata.

• InPlace indica la posizione del controllo come
specificato nella visualizzazione Screen Design o la
posizione dell'indicatore logico definita dalla
condizione SearchFor.

• Nessuna indica che il controllo non ha una posizione
specifica sulla schermata verde e che la sua funzione
è indipendente dalla schermata verde.

La posizione della schermata può essere definita anche
utilizzando la finestra Selezionare la posizione della
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schermata accessibile facendo clic sul pulsante accanto
al campo TextInsertionLocation .

BoundVariable Un'origine dati che i controlli possono utilizzare per
leggere o scrivere in modo che possano interagire tra
loro.

ControlTarget MainArea La destinazione del controllo è l'area specificata nel tema
attualmente selezionato, in cui il controllo viene
posizionato. MainArea è l'area occupata dalla schermata
verde.

Style Stringa vuota Lo stile definisce l'aspetto di un controllo. I suoi possibili
valori vengono visualizzati nell'elenco degli elementi presi
dal tema correntemente selezionato. Se non viene
specificato, viene utilizzato lo stile predefinito.

ColorSettings

Sfondo Specifica il colore utilizzato per lo sfondo del controllo.
Può essere:

• FromStyle: il colore viene ripreso dal colore definito
nello stile del tema.

• FromHost: viene usato il colore dello sfondo host.
• Personalizzato: è possibile selezionare un colore

dalla tavolozza dei colori.

Primo piano Il colore usato per il primo piano del controllo. Può
essere:

• FromStyle: il colore viene ripreso dal colore definito
nello stile del tema.

• FromHost: viene usato il colore del primo piano host.
• Personalizzato: è possibile selezionare un colore

dalla tavolozza dei colori.

FontSettings Specifica il carattere del testo usato:

• Grassetto, Corsivo e Sottolineato per i controlli
CheckBox, Label, RadioButton e Tooltip.

• Grassetto e Corsivo per il controllo Button.

RowOffset 0 Offset verticale relativo alla riga in cui l'indicatore logico è
posizionato. Gli indicatori logici vengono definiti dalla
condizione SearchFor. Un valore positivo o negativo
definisce la posizione della schermata come il numero di
righe in basso o in alto rispetto all'indicatore logico.

Un valore di offset non corretto può incidere
negativamente sulla posizione del controllo.

ColumnOffset 0 Offset orizzontale relativo alla colonna nella quale è
posizionato l'indicatore logico. Gli indicatori logici
vengono definiti dalla condizione SearchFor. Un valore
positivo o negativo definisce la posizione sulla schermata
come il numero di colonne dalla destra alla sinistra
dell'indicatore logico.

Un valore di offset non corretto può incidere
negativamente sulla posizione del controllo.

RowSpan 0 Se è diverso da zero, ignora l'altezza di un indicatore
logico definito dalla condizione SearchFor.
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ColumnSpan 0 Se è diverso da zero, ignora la larghezza di un indicatore
logico definito dalla condizione SearchFor.

ZOrder Il valore ZOrder più alto tra
tutti i controlli nella
schermata corrente nella
pagina Screen Design
eccetto Topmost + 1

Specifica l'ordine di sovrapposizione di due o più controlli.
I controlli con i valori ZOrder più alti vengono visualizzati
in cima all'elenco o quasi in primo piano.

TabOrder Predefinito Specifica l'ordine di spostamento del cursore alla
pressione del tasto Tab. L'ordine di tabulazione viene
visualizzato selezionando TabOrder nella barra degli
strumenti di Screen Designer.

Azioni
Le azioni vengono eseguite nell'ordine in cui sono aggiunte nella finestra di dialogo Azioni.

Azione Descrizione Valori

ClearField Cancella il contenuto di un
campo specificato in una
posizione specificata della
schermata.

FieldLocation La (riga, colonna) nella quale viene
inserito un testo sulla schermata.
InPlace indica la posizione del
controllo come specificato nella
visualizzazione Screen Design o la
posizione dell'indicatore logico definita
dalla condizione SearchFor.

La posizione della schermata può
essere definita anche utilizzando la
finestra Selezionare la posizione
della schermata accessibile facendo
clic sul pulsante accanto al campo
FieldLocation.

Email Invia un'e-mail all'indirizzo
specificato.

ActionTarget Indirizzo e-mail del destinatario.

EmulationCommand Esegue un comando di
emulazione specificato.

EmulationCommand I valori possibili sono indicati in
un elenco.

RunApplication Avvia un'applicazione
specificata sul computer
dell'utente.

ActionTarget

Linea di comando per l'esecuzione. Esempio:

C:\Program Files (x86)\Skype\Phone
\Skype.exe

AdditionalArguments

Argomenti dell'applicazione. Esempio:

/callto:+555555

I dati salvati dai controlli Collector possono essere
utilizzati per specificare parametri per ActionTarget e per
AdditionalArguments. AdditionalArguments.

RunMacro Esegue una macro
specifica.

ActionTarget Percorso completo del file macro da
eseguire o percorso relativo alla

80 | Tipi di controllo



Azione Descrizione Valori

cartella delle macro. I dati salvati dai
controlli Collector possono essere
utilizzati per specificare gli argomenti.

RunScript Esegue uno script specifico. ActionTarget Percorso completo dello script da
eseguire o percorso relativo alla
cartella degli script. I dati salvati dai
controlli Collector possono essere
utilizzati per specificare gli argomenti.

SetCursor Posiziona il cursore nella
posizione specificata della
schermata.

CursorLocation La (riga, colonna) in cui il testo deve
essere acquisito sulla schermata.
InPlace indica la posizione del
controllo come specificato nella
visualizzazione Screen Design o la
posizione dell'indicatore logico
definita dalla condizione SearchFor.

La posizione della schermata può
essere definita anche utilizzando la
finestra Selezionare la posizione
della schermata accessibile
facendo clic sul pulsante accanto al
campo CursorLocation.

SetText Inserisce il testo nella
posizione specificata dello
schermo di un campo non
protetto.

Se la posizione specificata
non è in alcun campo non
protetto, non viene eseguita
alcuna azione.

TextInsertionLocation La (riga, colonna) nella quale
viene inserito un testo sulla
schermata. InPlace indica la
posizione del controllo come
specificato nella
visualizzazione Screen
Design o la posizione
dell'indicatore logico definita
dalla condizione SearchFor.

La posizione della schermata
può essere definita anche
utilizzando la finestra
Selezionare la posizione
della schermata accessibile
facendo clic sul pulsante
accanto al campo
TextInsertionLocation.

ActionTarget Il testo da inserire.

SetValueToAVariable Crea una variabile globale e
ne imposta il valore. Se la
variabile globale esiste già,
il suo valore viene
ripristinato.

GlobalVariableName Nome della variabile globale.

Contenuto Valore della variabile globale.

Le espressioni che contengono
valori di variabili globali già
esistenti verranno utilizzate nella
forma %
%<other_variable_name>
%%.
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WebSite Esegue il browser
predefinito dell'utente per
navigare su un sito Web
specifico.

ActionTarget Indirizzo del sito Web. I dati salvati dai
controlli Collector possono essere
utilizzati per specificare gli argomenti.

Menu di scelta rapida del controllo
Quando si fa clic con il pulsante destro del mouse su un controllo, viene visualizzato un menu di scelta
rapida con le seguenti opzioni:

Opzione Descrizione

Converti in regola Converte un controllo statico nella visualizzazione Screen Design in un controllo
dinamico gestito da Rule Manager.

Taglia Taglia un controllo negli appunti Screen Designer.

Copia Copia un controllo negli appunti di Screen Designer.

Incolla Incolla un controllo dagli appunti di Screen Designer nella schermata corrente
visualizzata nell'area di lavoro della visualizzazione Screen Design.

Elimina Elimina un controllo.

Disattiva/Attiva Disattiva un controllo in modo che rimanga nel progetto, ma non venga utilizzato nella
schermata di personalizzazione. Un punto esclamativo viene visualizzato in alto a
destra del controllo per indicare che è disattivato. Per attivare un controllo, fare clic con
il pulsante destro del mouse sul controllo e selezionare Attiva dal menu a comparsa.

È possibile ancora modificare i controlli disattivati ma non verranno utilizzati su una
schermata personalizzata finché non verranno attivati.

Se si copia un controllo disattivato o lo si converte in una regola, il controllo resterà
disattivato.

Porta in secondo piano Se due o più controlli si sovrappongono, questa opzione manda il controllo selezionato
in secondo piano rispetto alla pila dei controlli.

Porta in primo piano Se due o più controlli si sovrappongono, questa opzione manda il controllo selezionato
in primo piano rispetto alla pila dei controlli.
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Procedure dettagliate
Questa sezione contiene ulteriori informazioni su Screen Designer, sui controlli e sulle regole.

Utilizzo dei temi
Un tema definisce il layout della schermata e l'aspetto di ogni controllo su tutte le schermate in un progetto
di personalizzazione.

Il layout della schermata ha una zona principale rettangolare al centro, che può essere circondata da aree
rettangolari (margini). I margini vengono definiti dal tema utilizzato.

L'area principale di una schermata può contenere qualsiasi tipo di controllo. Tuttavia, i margini possono
contenere solo pulsanti o immagini.

Nota: Per aggiungere i pulsanti ai margini di un tema, trascinare l'icona del controllo dalla griglia delle
proprietà nella visualizzazioneScreen Design. Per aggiungere le immagini ai margini di un tema,
utilizzare l'Editor temi.

Nell'esempio seguente, sono state aggiunte due immagini al tema della proprietà utilizzando l'Editor temi. I
due pulsanti al margine sinistro sono stati aggiunti dalla griglia delle proprietà nella visualizzazione Screen
Design:

Importante: se si modifica un tema, i margini del tema precedente scompaiono, insieme ai relativi
contenuti. Pertanto, si consiglia vivamente di scegliere un tema nelle prime fasi del progetto di
personalizzazione.

In Screen Designer, sono inclusi alcuni temi. Inoltre, è possibile usare l'Editor temi per progettare il proprio
tema.

Selezione di un tema
1. Selezionare Strumenti > Impostazioni progetto

Viene visualizzata la finestra di dialogo Impostazioni progetto.
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2. Fare clic su Temi nel riquadro a sinistra.

3. Fare clic su Modifica nel riquadro a destra. Viene visualizzata la finestra di dialogo Scegli tema.

4. Selezionare un'anteprima del tema da utilizzare dal riquadro a sinistra.

5. Fare clic su OK.

6. Fare clic su OK nella finestra di dialogo Impostazioni progetto. 

Il tema verrà applicato a tutte le schermate del progetto.

Creazione di un nuovo tema Windows
1. Selezionare Strumenti > Editor temi. 

Viene visualizzata la finestra Editor temi.
2. Selezionare File > Nuovo. 

Viene visualizzata la finestra di dialogo Crea tema.

3. Inserire un nome appropriato per il tema nel campo Nome tema.

4. Fare clic su OK. 

Viene visualizzata la schermata di design Editor temi.

5. Selezionare un design dal riquadro Layout. 

Il layout viene visualizzato nel riquadro centrale.

6. Nel riquadro Interfacce, selezionare BaseWindowsSkin dall'elenco a discesa. 

Nota: Se si seleziona un tema Windows, non è possibile modificare l'interfaccia di un controllo.

7. Nel riquadro centrale, selezionare un colore dall'elenco Sfondo anteprima tema per visualizzare un
colore di sfondo per il tema. 

Nota: Questo permette di visualizzare solo un'anteprima del colore. Per utilizzare un colore
specifico, è necessario modificare il colore di sfondo nella visualizzazione emulatore.

8. Per aggiungere uno sfondo o un'immagine in un riquadro del tema, selezionare il riquadro, quindi
selezionare il colore o l'immagine dall'elenco Sfondo o Immagine in base alle esigenze.

9. Una volta terminato, selezionare File > Chiudi. 

La schermata di design verrà chiusa.

10.Nella finestra Editor temi, selezionare File > Esci.

Creazione di un tema della schermata verde
1. Selezionare Strumenti > Editor temi. 

Viene visualizzata la finestra Editor temi.
2. Selezionare File > Nuovo. 

Viene visualizzata la finestra di dialogo Crea tema.

3. Inserire un nome appropriato per il tema nel campo Nome tema.

4. Fare clic su OK. 

Viene visualizzata la schermata di design Editor temi.

5. Selezionare un design dal riquadro Layout. 

Il layout viene visualizzato nel riquadro centrale.

6. Nel riquadro Interfacce, selezionare BaseGreenScreenSkin dall'elenco a discesa.

7. Opzionale: Selezionare un colore dall'elenco a discesa Colore di base. 

Ciò determina il colore base di primo piano utilizzato nel tema.
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8. Nel riquadro centrale, selezionare un colore dall'elenco Sfondo anteprima tema per visualizzare un
colore di sfondo per il tema. 

Nota: Questo permette di visualizzare solo un'anteprima del colore. Per utilizzare un colore
specifico, è necessario modificare il colore di sfondo nella visualizzazione emulatore.

9. Per aggiungere uno sfondo o un'immagine in un riquadro del tema, selezionare il riquadro, quindi
selezionare il colore o l'immagine dall'elenco Sfondo o Immagine in base alle esigenze.

10.Una volta terminato, selezionare File > Chiudi. 

La schermata di design verrà chiusa.

11.Nella finestra Editor temi, selezionare File > Esci.

Ricerca delle schermate della cronologia
È possibile cercare le schermate delle miniature nel pannello cronologia per le stringhe di testo che
vengono visualizzate su una schermata o come parte dell'ID di una schermata.

Nella parte inferiore del pannello cronologia, digitare una stringa di ricerca nel campo di ricerca. Le
miniature sono filtrate, pertanto rimangono solo le schermate che contengono la stringa di ricerca.

Creazione di schermate moderne con un'area di disegno
della schermata

Le schermate moderne spesso richiedono più spazio del layout della schermata in verde fisso. È possibile
rimuovere la schermata fissa definita dal terminale. Per effettuare questa operazione, definire le
impostazioni per un'area di disegno della schermata, quindi aggiungere controlli nello stesso modo che su
una schermata verde.

Oltre alle dimensioni delle schermate personalizzate, l'area di disegno della schermata supporta i tipi di
schermata seguenti:

• Modello 2 (24x80)
• Modello 3 (32x80)
• Modello 5 (27x132)

Un altro vantaggio derivante dall'utilizzo di un'area di disegno della schermata consiste nella possibilità di
posizionare un'area di disegno più grande su una schermata verde più piccola per ottimizzare lo spazio
sulla schermata.

Definizione delle impostazioni dell'area di disegno
predefinita
Per definire le impostazioni predefinite per l'area di disegno della schermata, utilizzare la finestra di dialogo
Impostazioni progetto.

Nota: È possibile specificare diverse impostazioni per una schermata selezionata selezionando
Strumenti > Area di disegno della schermata.

1. Selezionare Strumenti > Impostazioni progetto. 

Viene visualizzata la finestra di dialogo Impostazioni progetto.

2. Fare clic su Area di disegno della schermata nel riquadro sinistro. 

Le impostazioni dell'area di disegno della schermata vengono visualizzate nel riquadro destro.

3. Specificare le impostazioni desiderate: 
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Impostazione Descrizione

Dimensioni dell'area di disegno Nota: Le dimensioni dell'area di disegno non possono essere più
piccole delle dimensioni della schermata verde selezionata.

Numero di righe Specifica il numero di righe per la nuova schermata. Il numero predefinito
corrisponde al numero di righe sulla schermata verde.

Numero di colonne Specifica il numero di colonne per la nuova schermata. Il numero predefinito
corrisponde al numero di colonne sulla schermata verde.

Dimensioni del carattere
dell'area di disegno

Definisce le dimensioni del carattere. Il valore predefinito è 26 pt.

Dimensioni fisse del carattere Se selezionata, le dimensioni del carattere non vengono modificate se la
finestra viene ridimensionata.

Sfondo area di disegno

Colore Definisce il colore di sfondo. Il colore predefinito è bianco. Può essere
utilizzato con Immagine.

Immagine Fare clic sul pulsante acceleratore per aprire la finestra di dialogo Scegli
immagine per selezionare un'immagine per lo sfondo. Può essere utilizzato
con Colore.

Layout immagine Selezionare un'opzione tra:

Estendi
Riempi
Adatta
Affianca
Allinea al centro

Applica impostazioni
automaticamente a ogni nuova

schermata di cronologia

Se selezionata, un'area di disegno della schermata con le impostazioni
predefinite viene automaticamente applicata ad ogni nuova schermata di
cronologia importata.

Nota: Questa impostazione nasconde tutti i campi di schermata
verde. Pertanto si raccomanda di utilizzare Genera
automaticamente controlli per utilizzare questa impostazione.

Definizione delle impostazioni per una schermata
selezionata
1. Selezionare una schermata dal riquadro della cronologia.

2. Selezionare Strumenti > Area di disegno della schermata. 

Viene visualizzata la finestra di dialogo Area di disegno della schermata.

Nota: È anche possibile fare clic con il pulsante destro del mouse sulla schermata nell'area di
lavoro e selezionare Area di disegno della schermata > Impostazioni

3. Specificare le impostazioni desiderate: 

Impostazione Descrizione

Dimensioni dell'area di disegno Nota: Le dimensioni dell'area di disegno non possono essere più
piccole delle dimensioni della schermata verde selezionata.

Numero di righe Specifica il numero di righe per la nuova schermata. Il numero predefinito
corrisponde al numero di righe sulla schermata verde.
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Numero di colonne Specifica il numero di colonne per la nuova schermata. Il numero predefinito
corrisponde al numero di colonne sulla schermata verde.

Dimensioni del carattere
dell'area di disegno

Definisce le dimensioni del carattere. Il valore predefinito è 26 pt.

Dimensioni fisse del carattere Se selezionata, le dimensioni del carattere non vengono modificate se la
finestra viene ridimensionata.

Sfondo area di disegno

Colore Definisce il colore di sfondo. Il colore predefinito è bianco. Può essere
utilizzato con Immagine.

Immagine Fare clic sul pulsante acceleratore per aprire la finestra di dialogo Scegli
immagine per selezionare un'immagine per lo sfondo. Può essere utilizzato
con Colore.

Layout immagine Selezionare un'opzione tra:

Estendi
Riempi
Adatta
Affianca
Allinea al centro

4. Fare clic su OK.

Nota: Per sostituire le impostazioni predefinite dell'area di disegno della schermata con le
impostazioni appena definite, fare clic su Imposta come predefinito.

Copiare e incollare un'area di disegno della schermata
Se una schermata ha già un'area di disegno, è possibile copiare la schermata e le sue impostazioni, quindi
applicarle a un'altra schermata. Per eseguire questa operazione:

1. Selezionare una schermata dal riquadro della cronologia.

2. Fare clic con il pulsante destro del mouse sull'area di lavoro e selezionare Copia area di disegno dal
menu a comparsa.

3. Selezionare un'altra schermata dal riquadro della cronologia.

4. Fare clic con il pulsante destro del mouse sull'area di lavoro e selezionare Incolla area di disegno dal
menu a comparsa. 

L'area di disegno della schermata copiata e le sue impostazioni vengono applicate alla schermata.

Rimozione di un'area di disegno della schermata
Per rimuovere un'area di disegno della schermata da una schermata verde, fare clic con il pulsante destro
del mouse nell'area di lavoro, quindi selezionare Rimuovi area di disegno dal menu a comparsa. Questa
operazione non influisce sui controlli aggiunti al progetto Plus.

Esempio
Nella sezione Aggiunta di controlli, sono stati aggiunti i controlli alle schermate dal Demo Host per
conferire un aspetto più moderno. In questo esempio, viene descritto come rendere le schermate ancora
più moderne.

Tramite un'area di disegno della schermata, è possibile conferire alla schermata iniziale un aspetto lineare
e moderno:
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Notare che, tramite la finestra Editor temi, è possibile aggiungere un logo e un banner in alto.

Selezionando il sistema host, si accede alla stessa schermata di prima, ma con un aspetto più nuovo:

Facendo clic su Order Entry, si accede alla schermata SALES ORDER ENTRY - CUSTOMER:
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Notare che, tramite i controlli generati automaticamente, si sostituisce completamente la schermata verde
originale.

Identificazione delle schermate

Informazioni sull'identificativo della schermata
Screen Designer supporta le seguenti modalità di identificazione delle schermate:

Predefinito Un identificativo calcolato dai dati del campo di una schermata. Utilizzato per
impostazione predefinita.

Per personalizzare le schermate, è necessario assegnare un ID schermata ad ogni
schermata. Purtroppo, questo ID schermata predefinito potrebbe non essere sufficiente.
Ciò si verifica quando diverse schermate, che dovrebbero essere distinte l'una dall'altra,
hanno lo stesso ID schermata. Si può anche verificare quando diversi schermi, che
devono essere affrontate come lo stesso, avere diverse ID di schermo.

Basato su
selezione

Un identificativo basato sui contenuti di una o più selezioni di schermata. Quando l'ID
schermata predefinito non è sufficiente, è possibile selezionare i contenuti di una
posizione della schermata in modo che funga da ID schermata. Se si effettua più di una
selezione, il contenuto di ciascuna selezione viene unito per formare l'ID schermata. Ogni
selezione è limitata all'altezza di una riga sulla schermata.

Nota: Prima di iniziare a personalizzare le schermate del progetto, è necessario scegliere il tipo di ID
schermata predefinito o un tipo di ID schermata basato su selezione. Non è possibile modificare il tipo
di ID schermata una volta iniziata la personalizzazione di una schermata.

Identificazione di
schermo
personalizzato

Per ogni schermata registrata durante la sessione è possibile definire un algoritmo
identificativo personalizzato. Per l'identificativo di schermata personalizzata, definire
un gruppo di aree selezionate su una schermata e specificare un nome per loro. In
questo modo vengono definiti i dati della schermata per distinguerla da altre
schermate del progetto. Il nome dell'identificativo personalizzato viene assegnato
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come ID schermata per ogni schermata del progetto che ha esattamente gli stessi
dati in esattamente le stesse aree selezionate come identificativo personalizzato.

È possibile scegliere un identificativo di schermata basato su selezione, un identificativo di schermata
personalizzato, o una combinazione di entrambi. In questo modo, è possibile distinguere tra schermate che
altrimenti avrebbero lo stesso ID o identificare schermate simili che altrimenti avrebbero diversi ID.

Definizione dell'identificativo di schermata basato su
selezione
1. Selezionare Strumenti > Impostazioni progetto. 

Viene visualizzata la finestra Impostazioni progetto.

2. Sulla pagina ID schermata, fare clic su Seleziona vicino a Basato sulla selezione. 

Viene visualizzata la finestra Selezione.

3. Selezionare un'anteprima di schermata nel riquadro a sinistra.

4. Nell'area di lavoro, selezionare una porzione di testo sulla schermata disegnando un bordo rettangolare
all'interno di una riga di schermata singola con il mouse. 

Il testo selezionato viene aggiunto come ID a qualsiasi schermata del progetto che ha lo stesso testo
nella stessa posizione.

5. Opzionale: È anche possibile aggiungere altre selezioni di schermate per formare l'ID schermata. Il
testo in ogni posizione della schermata selezionata viene unito per formare l'ID schermata.

6. Fare clic su OK.

7. Fare clic su OK nella finestra Impostazioni progetto.

Rimozione di una selezione

Per rimuovere una selezione, fare clic con il pulsante destro del mouse sulla selezione Rimuovi questa
selezione dal menu a comparsa.

Definizione dell'identificativo della schermata
personalizzata
1. Selezionare Strumenti > Impostazioni progetto. 

Viene visualizzata la finestra Impostazioni progetto.

2. Sulla pagina ID schermata, fare clic su Gestisci identificativo schermata. 

Viene visualizzata la finestra Gestisci identificativo schermata.

3. Selezionare un'anteprima dal riquadro a sinistra.

4. Fare clic su Aggiungi identificativo personalizzato nel riquadro a destra.

5. Selezionare le aree di testo sulla schermata disegnando bordi rettangolari all'interno delle righe di una
singola schermata con il mouse. 

Il riquadro della cronologia a sinistra viene filtrato per mostrare soltanto le schermate che hanno alcune
aree di testo nella stessa posizione selezionata dall'utente.

6. Scrivere un nome nel campo Nome.

7. Opzionale: Selezionare Usa con ID base. L'ID base risulta dal tipo di ID schermata scelto prima
dell'avvio della personalizzazione delle schermate. Quando questa opzione è selezionata, l'ID base
viene utilizzato come forma aggiuntiva di identificativo della schermata. 

Il nome specificato viene utilizzato come ID schermata personalizzato per ogni schermata del progetto
che:
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• Abbia le stesse aree di testo nelle stesse posizioni selezionate.
• Abbia lo stesso ID base (se Usa con ID base è selezionato).

Nota: L'ID base viene visualizzato nella parte superiore di ogni anteprima nel riquadro a sinistra,
mentre l'ID schermata viene visualizzato nella parte inferiore di ogni anteprima.

8. Fare clic su OK. 

Nota: Effettuare soltanto un identificativo personalizzato della schermata prima di fare clic su OK.

9. Fare clic su OK nella finestra Impostazioni progetto.

Rimozione dell'identificativo di schermata personalizzata:

Per rimuovere una selezione, fare clic con il pulsante destro del mouse sulla selezione Rimuovi questa
selezione dal menu a comparsa.

Notes:

• Non è possibile definire lo stesso ID schermata personalizzato per due schermate differenti se una
o entrambe sono personalizzate.

• Una schermata non può avere più di un ID schermata personalizzata. Non è possibile specificare
un ID schermata personalizzata se la schermata ne ha già uno.

• Una ambiguità di ID schermata verrà causata se si tenta di importare un altro progetto dove
almeno una schermata è adatta all'ID personalizzato del progetto base, ma quella schermata ha
già un ID schermata personalizzata. La schermata interessata verrà contrassegnata con
ambiguità di ID schermata nella visualizzazione Screen Design.

• Non è possibile importare un altro progetto con una schermata con ambiguità di ID schermata. Il
progetto deve essere rivisto al fine di risolvere il problema.

Gestione dei controlli

Generazione automatica dei controlli
In alcuni casi, è possibile ricreare l'intera schermata. È possibile effettuare questa operazione generando i
controlli Label ed InputField in modo automatico per tutti i campi protetti e non protetti su una schermata
verde. Per eseguire questa operazione:

1. Selezionare Strumenti > Impostazioni progetto. 

Viene visualizzata la finestra di dialogo Impostazioni progetto.

2. Fare clic su Genera automaticamente controlli nel riquadro a sinistra.

3. Specificare le impostazioni desiderate: 

Selezionare... Per eseguire questa operazione...

Genera controlli Label Se selezionata, vengono creati i controlli Label per ogni
campo protetto sullo schermo.

Escludi controlli Label creati dai campi vuoti Se selezionata, esclude i controlli di etichetta creati da
campi protetti che non contengono testo. Disponibile
solo se viene selezionata l'opzione Genera controlli
Label.

Genera controlli InputField Se selezionata, vengono creati i controlli Input per ogni
campo non protetto sullo schermo.

Genera automaticamente controlli su tutte le nuove
schermate di cronologia

Se selezionata, vengono generati automaticamente i
controlli Label e InputField su tutte le schermate di
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Selezionare... Per eseguire questa operazione...

cronologia recentemente importate. Deselezionata per
impostazione predefinita.

4. Fare clic su OK.

5. Per generare automaticamente i controlli sulla schermata corrente, selezionare Strumenti > Genera
automaticamente controlli.

Modifica del livello di opacità
È possibile utilizzare il dispositivo di scorrimento sulla barra degli strumenti per modificare l'opacità di tutti i
controlli su una schermata passando dall'opacità totale a un'opacità del 20%.

Facendo clic sull'icona Livello di opacità appare il dispositivo di scorrimento dell'opacità che attiva/
disattiva l'opacità.

Selezione di più controlli
È possibile selezionare più di un controllo in qualsiasi momento per effettuare la stessa operazione una
volta nei controlli selezionati, anziché una volta per ogni singolo controllo.

È possibile selezionare controlli in uno dei seguenti modi:

• Utilizzare il mouse per tracciare un'area di schermata contenente i controlli che si desidera selezionare.
• Premere Ctrl+A per selezionare tutti i controlli sulla schermata.
• Fare clic con il pulsante destro del mouse sullo sfondo della schermata e selezionare Seleziona tutto.
• Utilizzare Ctrl+Clic per attivare/disattivare la selezione di una schermata.

È possibile eseguire le seguenti azioni nei controlli selezionati:

• Sposta (utilizzando il mouse o i tasti di direzione)
• Elimina
• Taglia
• Copia
• Incolla
• Duplica

Nota: Non è possibile selezionare i controlli Gestione regole come parte di una selezione multipla.

Utilizzo dei controlli di regole
I controlli di regole sono controlli creati utilizzando Gestione regole.

Informazioni sui controlli di regole
Quando si creano i controlli di regole, appaiono anche nella vista Screen Design. Per impostazione
predefinita, questa funzionalità è attivata. È possibile mostrare o nascondere i controlli di regole
selezionando Visualizza > controlli di regole.

I controlli di regole sono progettati per essere utilizzati su più schermate. Essi sono quindi visibili nella
visualizzazione Screen Design in uno stile diverso dai controlli su un'unica schermata, così si possono
facilmente distinguere tra di loro.

È possibile modificare i controlli di regole nella visualizzazione Screen Design come in Gestione Regole.
Tuttavia, non è possibile ridimensionare, spostare, eliminare, copiare o duplicare questi controlli, come
indicato dal lucchetto nell'angolo in alto a destra del controllo.
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Modifica dei controlli di regole
Come per il controllo per un'unica schermata, è possibile modificare le proprietà del controllo utilizzando la
griglia delle proprietà.

1. Per modificare un controllo di regola nella visualizzazione Screen Design, fare clic con il pulsante
destro del mouse sul controllo e selezionare Modifica regola dal menu a comparsa. 

La regola viene aperta in Creazione guidata delle regole.

Nota: Quando si modifica un controllo di regola, esso influenza tutti i controlli creati nella regola
d'origine.

2. Per visualizzare un controllo di regola, fare clic con il pulsante destro del mouse e selezionare Mostra
regola dal menu a comparsa. 

La regola viene aperta nella finestra Gestione regole.

Modificare dei dati della tabella in modalità Plus
È possibile modificare i dati della tabella in modalità Plus utilizzando i controlli configurati in precedenza in
Plus.

Questo esempio mostra come aggiungere una casella di elenco combo a ciascuna riga di una tabella.

Configurazione dei controlli della tabella in Screen
Designer
1. Aprire il progetto DemoHost creato in precedenza.

2. Accedere alla schermata EUROPEAN CUSTOMER LIST.

3. Selezionare la tabella.

4. Nella griglia delle proprietà, fare clic sul pulsante acceleratore vicino a Columns. 

Viene visualizzata la finestra di dialogo Columns.

5. Nel riquadro Column Items, selezionare 5 - Column - Country.

6. Nel riquadro Properties, selezionare Combo dall'elenco Control Type: 
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7. Fare clic sul pulsante acceleratore vicino all'elenco. 

Viene visualizzata la finestra di dialogo Combo Control Settings:

8. Fare clic sul pulsante acceleratore in Entries. 

Viene visualizzata la finestra di dialogo Entries.

9. Fare clic sul pulsante Add per creare una voce combo.

10.Nel riquadro Properties, digitare Belgium nel campo Entry: 

11.Creare altre voci combo per: 

Gran Bretagna
Francia
Germania
Italia

12.Al termine, fare clic su OK.

13.Fare clic su OK nella finestra di dialogo Combo Control Settings.

14.Fare clic su OK nella finestra di dialogo Columns.

15.Salvare il progetto e creare il Archivio Plus.

Utilizzo dei controlli Table in modalità Plus
1. Connettersi a Demo Host e attivare la modalità Plus.

2. Associare il Archivio Plus appena generato alla sessione host.

3. Accedere alla schermata EUROPEAN CUSTOMER LIST. 

La colonna Country ora contiene un elenco combo su ciascuna riga.
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4. Sulla prima riga, selezionare Italy dall'elenco: 

5. Fare clic su Save in basso nella tabella.

Eseguire un'azione Table relativa a una posizione di riga
In alcune tabelle host, la selezione di una riga richiede di eseguire un'azione in un campo che si trova in
una posizione relativa rispetto a quella riga. Ad esempio, è possibile sia presente un campo di immissione
vicino a ogni riga di una tabella e la selezione di una riga potrebbe richiedere una determinata azione nel
campo relativo corrispondente.

È possibile effettuare le seguenti azioni del controllo Table, relative a una posizione di riga:

SetText
SetCursor
ClearField

La seguente figura mostra un controllo GridCollector nel Screen Designer. La freccia indica la posizione
della colonna più a sinistra della riga selezionata. La posizione relativa viene calcolata come offset da quel
punto, con la colonna più a sinistra rappresentata come (0,0):
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In questo esempio, la posizione per eseguire l'azione si trova nella colonna Option sulla stessa riga. Si
tratta di cinque celle della schermata a sinistra partendo dall'inizio della riga selezionata. Di conseguenza,
l'offset della riga è 0 e l'offset della colonna è -5.

Per configurare la tabella:

1. In , aggiungere Screen Designer a una tabella: 

2. Posizionare un controllo sul controllo Table.
3. Nella griglia delle proprietà, deselezionare IsMoreButtonVisible.
4. Deselezionare IsAutoNavigateOnLoad.
5. Selezionare IsExportButtonVisible.
6. Fare clic sul pulsante acceleratore vicino al campo DefaultRowCommand. 

Viene visualizzata la finestra di dialogo DefaultRowCommand.
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7. Selezionare SetText dall'elenco Select type.

8. Fare clic su Add.

9. Nel riquadro Properties, digitare X nel campo Text.

10.Selezionare Relative dall'elenco TextInsertionLocation.

11.Nel riquadro Offset, lasciare Row su 0 e impostare Column su -5: 

12.Fare clic su OK.

13.Salvare il progetto e creare il Archivio Plus.

14.In modalità Plus, quando si fa doppio clic sulla riga di una tabella, viene visualizzata una X nella
colonna Option: 

Aggiunta di azioni ClearField:

Se si desidera una sola X alla volta per riga selezionata, è possibile aggiungere un'azione ClearField per
ciascuna riga della tabella:

Procedure dettagliate | 97



Quando si fa doppio clic su una riga, una X viene visualizzata sulla riga in questione e rimossa da qualsiasi
riga selezionata in precedenza.

Utilizzare i controlli per impostare una variabile
È possibile utilizzare il contenuto di un controllo di input, come un controllo InputField, per impostare una
variabile che può essere utilizzata, ovunque e in qualsiasi momento, mediante l'azione di un altro controllo.
Per effettuare questa operazione, utilizzare l'azione BoundVariable del controllo di input.

I seguenti controlli di input utilizzano variabili collegate:

• Calendar
• CheckBox
• Chooser
• InputField
• RadioButton

Utilizzo dei componenti Web in Plus
Plus può richiamare applicazioni e componenti Web tramite uno o più dei seguenti controlli:

Button Un controllo dell'interfaccia utente con etichetta. Può richiamare un'applicazione, uno script,
un URL o una pagina Web.

WebFrame Crea un'icona tramite un'immagine. È possibile impostare le dimensioni del riquadro. Valido
solo per gli URL del browser Web. Non viene visualizzata alcuna barra degli indirizzi.

Trasmissione dei parametri ad un'applicazione o una
pagina Web
È possibile trasmettere i parametri ad un'applicazione o una pagina Web tramite il controllo Collector.
Posizionare un controllo Collector sui campi di dati utilizzati da Plus per acquisire i dati. Durante
l'esecuzione dell'applicazione, non viene visualizzato nulla per indicare che si tratta di un campo di raccolta
dei dati.

È possibile aggiungere i controlli Collector nella visualizzazione Screen Design:
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Nota: I controlli Collector devono coprire l'intero campo di dati per poter contenere le stringhe lunghe.

Durante la configurazione di un controllo Collector, è possibile assegnargli un nome nella griglia delle
proprietà. Questo nome deve essere univoco nell'archivio Plus. È possibile fare riferimento ai dati
memorizzati nel database come %%Name%%. Nella figura riportata sopra, il Name del primo strumento di
raccolta è MapCity e il nome della relativa variabile globale è %%MapCity%%.

La proprietà TrimSpaces ridimensiona la lunghezza della stringa di dati rimuovendo gli spazi finali. Nella
maggior parte delle applicazioni, questa opzione deve essere pari a 1.

Creazione di oggetti Web e URL
La prima operazione da effettuare consiste nella creazione di un URL funzionante utilizzando una serie
consolidata di parametri per un indirizzo noto. Ad esempio, questo parametro di Google Maps viene
utilizzato per il parcheggio di un ufficio nel Maryland:

http://maps.google.com/maps?q=700 King Farm,Rockville,MD

Copiare l'URL funzionante in un editor come Blocco note in modo da poterlo modificare per l'utilizzo in
Screen Designer. Ad esempio, la seguente stringa ricrea la stringa dell'indirizzo:

%%MapAddr%%,%%MapCity%%,%%MapState%%

Notare che le virgole (,) utilizzate come delimitatori nel comando di Google, si trovano comunque nella
stringa Plus.

Aggiungere un controllo WebFrame per ricevere i dati dal controllo WebFrame:
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Il comando da copiare e incollare nel campo WebFrame URLSource è:

http://maps.google.com/maps?q=%%MapAddr%%,%%MapCity%%,%%MapState%%

In modalità Plus, il controllo Plus acquisisce le informazioni digitate. Una volta fatto clic su di esso, il
controllo WebFrame recupera questi dati e visualizza la posizione dell'indirizzo su una mappa in una
finestra remota.

Man mano che le stringhe di caratteri diventano più complesse, assume maggiore importanza la fase di
test. Ad esempio, la stringa seguente richiama la funzione dei grafici di Google per un grafico a torta.
Notare che l'URL originale include una sezione contenente sia le etichette (AREA-A, ecc.) che i dati del
grafico (T=:100,300,200,50). Altri dati modificabili includono colori, formati e dimensioni:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:100,300,200,50&chdl=AREA-A|AREA-B|AREA-C|AREA-
D&chtt=TOYS

Come nell'esempio di Google Maps, è necessario sostituire la parte dei dati di questo URL con le variabili
raccolte dalla schermata Plus. In questo caso, la parte dei dati (specificata da chd), diventa:

chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%%

Il nuovo URL da utilizzare con il controllo WebFrame diventa:

http://chart.googleapis.com/chart?chs=300x150&cht=p3&chco=0000FF|00FF00|
FF0000|FFFF00&chds=0,1000&chd=t:%%R1Jtoy%%,%%R2Jtoy%%,%%R3Jtoy%%,%%R4Jtoy%
%&chdl=Region1|Region2|Region3|Region4&chtt=TOYS

In un'applicazione reale, è possibile anche modificare i dati dell'etichetta in modo dinamico. Una sezione
dell'etichetta sarà, pertanto, simile a quella riportata di seguito:

chdl=%%Label1%%|%%Label2%%|%%Label3%%|%%Label4%%

È possibile provare con l'URL del grafico a torta di Google utilizzando la schermata TOYS nel Demo Host.

Importazione di altri progetti
È possibile importare altri progetti di personalizzazione da unire a un progetto attualmente aperto in
Screen Designer.

Per effettuare questa operazione, selezionare File > Importa progetto.
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Notes:

• Non è possibile importare un progetto se il progetto base non è aperto.
• Il nome e il tema del progetto saranno gli stessi del progetto corrente.

La tabella sottostante fornisce informazioni su alcuni casi in cui non tutti i dati potrebbero venire inclusi in
un'importazione.

Se... Allora...

La configurazione dell'ID della schermata dell'altro
progetto è diversa da quella definita nel progetto base.

Dopo il tentativo di importazione, l'operazione si
interrompe e viene visualizzato un messaggio di errore.

Viene importato un progetto un in cui sono definiti gli ID
della schermata personalizzata.

Se tutti gli ID della schermata personalizzata sono validi,
vengono aggiunti all'elenco degli ID della schermata
personalizzata del progetto base.

Viene importato un progetto un in cui sono definiti gli ID
della schermata personalizzata. Tuttavia, uno dei nomi ID
della schermata personalizzata esiste già nel progetto
base, anche se gli ID della schermata personalizzata non
sono identici.

L'ID della schermata personalizzata viene aggiunto al
progetto con un nuovo nome: Origcustom screen
ID - Copy, Origcustom screen ID - Copy
(2). Eventuali riferimenti all'ID della schermata
personalizzata rinominati vengono modificati di
conseguenza.

Viene importato un progetto con una regola identica ad
una delle regole presenti nel progetto base.

Le regole duplicate vengono visualizzate una sola volta.

Viene importato un progetto un in cui sono definiti gli ID
della schermata personalizzata. Uno degli ID della
schermata personalizzata non è valido perché è stato
assegnato ad una schermata con un altro ID della
schermata personalizzata.

Non tutte le regole correlate agli ID della schermata
personalizzata vengono unite nel progetto. Le
informazioni vengono visualizzate nella finestra di dialogo
dei risultati.

Viene importato un progetto che include una risorsa
locale.

Se il nome della risorsa esiste già, è possibile selezionare
un nome tra:

• Copy and Replace

• Don’t Copy

• Copy, but keep both files

È, inoltre, possibile importare altri progetti di personalizzazione tramite la riga di comando Screen
Designer. Vedere Uso della riga di comando di Screen Designer.

Uso della riga di comando di Screen Designer
È possibile utilizzare la riga di comando di Screen Designer per:

• Creare uno o più file di Archivio Plus dai file di progetto di Screen Designer.
• Importare più progetti in un progetto corrente di Screen Designer.

Sintassi

<Install_Dir>\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe [/P
<project_file_path> | /L <project_file_list_path>] [/O <output_dir>][/S] | /I
<config_file> | /?

dove:

<Install_Dir> È la cartella in cui è installato Screen Designer.

/P <project_file_path> È il percorso completo di un singolo file di progetto.
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/L <project_file_list_path> È il percorso completo di un file che contiene un elenco di file di
progetto.

Ogni percorso e nome file deve trovarsi su una riga separata. È
possibile usare il segno del cancelletto (#) per impostare una riga
come commento.

/O <output_dir> È il percorso completo in cui vengono esportati gli archivi Plus.
Facoltativo: Se non specificato, viene utilizzata la cartella
<Install_Dir>\Plus\ScreenDesigner.

/S Salva il progetto dopo che è stato creato il Archivio Plus.

/I <config_file> È il percorso completo dell'elenco configurato dei progetti da
importare.

/? Mostra queste informazioni sulla schermata.

Generazione dei file di personalizzazione

Sintassi

<Install_Dir>\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe [/P
<project_file_path> | /L <project_file_list_path>] [/O <output_dir>][/S]

Esempio: Generazione di un singolo archivio Plus

RumbaScreenDesignerCLI.exe /P C:\Users\<user_name>\AppData\Local\Micro Focus
\Rumba\Plus\Projects\TableTest\TableTest.rsdp /O C:\Users\<user_name>\AppData
\Local\Micro Focus\Rumba\Plus\Rules /S

Esempio: Generazione di più archivi Plus

RumbaScreenDesignerCLI.exe /L C:\Screen Designer\Projects\ProjectList.txt /O
C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Rules /S

Esempio del contenuto dell'elenco dei file del progetto:

C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects\u1\u1.rsdp
#C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects\unique
\unique.rsdp
C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects\TableTest
\TableTest.rsdp
C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\longtable3\longtable3.rsdp
C:\work\rumba_mobile\TestApplications\TestPlanAppCSIMVS\TestAppCSIMVS
\TestAppCSIMVS.rsdp

Nota: È possibile usare il segno del cancelletto (#) per impostare una riga come commento.

Importazione dei file del progetto

Sintassi

<Install_Dir>\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe /I <config_file>

Esempio

<Install_Dir>\Plus\ScreenDesigner\RumbaScreenDesignerCLI.exe /I C:\Screen
Designer\Projects\ImportFileList.txt
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Esempio del contenuto dell'elenco dei file del progetto:

duplicateresource=ckb
baseproject=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects1\MergeProjects1.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects2\MergeProjects2.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects3\MergeProjects3.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects2\MergeProjects2.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\a1\a1.rsdp
project=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\WYSIWYG\WYSIWYG\WYSIWYG.rsdp
saveto=C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus\Projects
\MergeProjects20

dove:

duplicateresource Specifica le opzioni di copia per le risorse duplicate:

cr Copia e sostituisce.

dc Non copia.

CKB Copia, ma mantiene entrambi i file.

baseproject Il progetto base in cui saranno importati i progetti.

progetto Il percorso assoluto o relativo per il file del progetto.

saveto Il percorso del progetto unito risultante. Se non specificato, viene utilizzato il progetto
base. Se il progetto non esiste, viene creato un nuovo progetto nella stessa
posizione con un nome corrispondente al nome della cartella. Per esempio, se il
percorso è:

C:\Users\<user_name>\AppData\Local\Micro Focus\Rumba\Plus
\Projects\MergeProjects20

Il progetto creato è denominato MergeProjects20.

Utilizzo di Screen Designer autonomo
Oltre all'utilizzo di Screen Designer da Rumba+ Desktop, è possibile utilizzarlo come applicazione
autonoma. È possibile utilizzare Screen Designer autonomo anche se Rumba+ non è in esecuzione.

1. Dal menu Start di Windows, selezionare Start > Tutti i programmi > Micro Focus Rumba+ Desktop
> Rumba+ Desktop Strumenti > Rumba+ Desktop Screen Designer. 

Screen Designer viene avviato come applicazione autonoma.

2. Per chiudere Screen Designer, selezionare File > Esci.

È possibile utilizzare Screen Designer autonomo anche se Rumba+ non è in esecuzione. Tuttavia, è molto
utile eseguire contemporaneamente Rumba+. Ad esempio, è possibile effettuare modifiche ad un progetto
in Screen Designer autonomo, creare il Archivio Plus, passare a Rumba+, quindi, una volta caricato il
progetto, disattivare e attivare la modalità Plus per visualizzare immediatamente i risultati delle modifiche.
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Personalizzare le schermate in una sessione Plus
È possibile aggiungere e configurare controlli semplici direttamente nelle schermate verdi. Questi controlli
saranno univoci nell'ambiente di lavoro e funzioneranno insieme alla personalizzazione di Screen
Designer.

La procedura per aggiungere un controllo è molto rapida e richiede poche operazioni di configurazione.

È possibile aggiungere i seguenti controlli a una schermata in una sessione Plus:

• Calendar
• CheckBox
• Chooser
• Label
• RunMacro

Notes:

• Si applica solo ai temi delle schermate verdi.
• Si applica solo al riquadro 3270 e alle sessioni 5250 AS/400.

Aggiunta di un controllo Calendar
Utilizzare Calendar per selezionare una data.

1. Plus > Contenuti utente > Mostra/nascondi pannello di controllo . 

Il pannello di controllo viene visualizzato a destra di Rumba+ Desktop.

2. Trascinare il controllo Calendar dal pannello di controllo nella posizione desiderata nella schermata. 

Sulla schermata viene visualizzata una griglia e vengono evidenziati i campi non protetti. Nel pannello
di controllo viene visualizzata la griglia delle proprietà Calendar.

3. Selezionare il formato data richiesto dall'elenco DateFormat nella griglia delle proprietà.

4. Fare clic sul campo non protetto in cui si desidera visualizzare la data. 

È possibile modificare la posizione in un secondo momento facendo clic sul pulsante acceleratore nel
campo InsertionLocation, quindi sulla posizione desiderata nella schermata.

5. Opzionale: In alternativa, è possibile trascinare il controllo direttamente su un campo non protetto. Il
controllo viene posizionato automaticamente e la posizione del campo viene utilizzata per inserire la
data.

6. Per finire, fare clic sul segno di spunta vicino al pannello di controllo. 

La griglia delle proprietà viene chiusa.

È possibile spostare il controllo trascinandolo in un'altra posizione sulla schermata.

Proprietà

Proprietà Impostazione predefinita Descrizione

DateFormat Determinato dalle impostazioni locali
del computer.

Formato del testo della data.

InsertionLocation Quando il controllo viene trascinato
su un campo non protetto, la
posizione del campo. In caso
contrario, nessuno.

Posizione sulla schermata in cui deve
essere visualizzata la data
selezionata. Può essere specificato
facendo clic sul pulsante
acceleratore. Se il controllo viene
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Proprietà Impostazione predefinita Descrizione

trascinato su un campo non protetto,
la posizione viene determinata in
base alla posizione del campo.

Aggiunta di un controllo CheckBox
Il controllo CheckBox funge da controllo di attivazione/disattivazione così come una tipica casella di
controllo. CheckBox fornisce all'utente la scelta di una opzione tra due, come Sì e No, quindi visualizza il
testo risultante nella posizione specificata sullo schermo.

1. Plus > Contenuti utente > Mostra/nascondi pannello di controllo . 

Il pannello di controllo viene visualizzato a destra di Rumba+ Desktop.

2. Trascinare il controllo CheckBox dal pannello di controllo nella posizione desiderata nella schermata. 

Sulla schermata viene visualizzata una griglia e vengono evidenziati i campi non protetti. Nel pannello
di controllo viene visualizzata la griglia delle proprietà CheckBox.

3. Nel campo CheckedValue, digitare il testo da visualizzare quando si seleziona il controllo.

4. Nel campo UncheckedValue, digitare il testo da visualizzare quando si deseleziona il controllo.

5. Fare clic sul campo non protetto in cui si desidera visualizzare il testo. 

È possibile modificare la posizione in un secondo momento facendo clic sul pulsante acceleratore nel
campo InsertionLocation, quindi sulla posizione desiderata nella schermata.

6. Opzionale: In alternativa, è possibile trascinare il controllo direttamente su un campo non protetto. Il
controllo viene posizionato automaticamente e la posizione del campo viene utilizzata per inserire il
testo. Il controllo viene anche ridimensionato automaticamente per adattarlo al campo selezionato.

7. Per finire, fare clic sul segno di spunta vicino al pannello di controllo. 

La griglia delle proprietà viene chiusa.

È possibile spostare il controllo trascinandolo in un'altra posizione sulla schermata.

Proprietà

Proprietà Impostazione predefinita Descrizione

CheckedValue Y Il testo da visualizzare quando si
seleziona il controllo.

UncheckedValue N Il testo da visualizzare quando si
deseleziona il controllo.

InsertionLocation Quando il controllo viene trascinato
su un campo non protetto, la
posizione del campo. In caso
contrario, nessuno.

Posizione sulla schermata in cui deve
essere visualizzato il testo
selezionato. Può essere specificato
facendo clic sul pulsante
acceleratore. Se il controllo viene
trascinato su un campo non protetto,
la posizione viene determinata in
base alla posizione del campo.

Aggiunta di un controllo Chooser
Chooser viene visualizzato sulla schermata come controllo a discesa. Chooser viene utilizzato per inserire
dati nel campo sulla schermata selezionando una voce dall'elenco.
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1. Plus > Contenuti utente > Mostra/nascondi pannello di controllo . 

Il pannello di controllo viene visualizzato a destra di Rumba+ Desktop.

2. Trascinare il controllo Chooser dal pannello di controllo nella posizione desiderata nella schermata. 

Sulla schermata viene visualizzata una griglia e vengono evidenziati i campi non protetti. Nel pannello
di controllo viene visualizzata la griglia delle proprietà Chooser.

3. Nel campo ChooserItems, digitare un elenco di valori, separati da un punto e virgola da visualizzare
nell'elenco a discesa Chooser. Ad esempio, Monday; Tuesday; Wednesday.

4. Fare clic sul campo non protetto in cui si desidera visualizzare il valore selezionato. 

È possibile modificare la posizione in un secondo momento facendo clic sul pulsante acceleratore nel
campo InsertionLocation, quindi sulla posizione desiderata nella schermata.

5. Opzionale: In alternativa, è possibile trascinare il controllo direttamente su un campo non protetto. Il
controllo viene posizionato automaticamente e la posizione del campo viene utilizzata per inserire il
testo. Il controllo viene anche ridimensionato automaticamente per adattarlo al campo selezionato.

6. Per finire, fare clic sul segno di spunta vicino al pannello di controllo. 

La griglia delle proprietà viene chiusa.

Proprietà

Proprietà Impostazione predefinita Descrizione

ChooserItems Elenco vuoto Elenco di valori, separati da un punto
e virgola, da visualizzare nell'elenco a
discesa Chooser. Il valore selezionato
viene visualizzato nella posizione
della schermata da Chooser.

InsertionLocation Quando il controllo viene trascinato
su un campo non protetto, la
posizione del campo. In caso
contrario, nessuno.

Posizione sulla schermata in cui deve
essere visualizzato il testo
selezionato. Può essere specificato
facendo clic sul pulsante
acceleratore. Se il controllo viene
trascinato su un campo non protetto,
la posizione viene determinata in
base alla posizione del campo.

Aggiunta di un controllo Label
Label è un controllo di riga singola utilizzato per posizionare un testo statico in una posizione specificata
della schermata.

1. Plus > Contenuti utente > Mostra/nascondi pannello di controllo . 

Il pannello di controllo viene visualizzato a destra di Rumba+ Desktop.

2. Trascinare il controllo Label dal pannello di controllo nella posizione desiderata nella schermata. 

Sulla schermata viene visualizzata una griglia. Nel pannello di controllo viene visualizzata la griglia delle
proprietà Label.

3. Nel campo LabelContent, digitare il testo da visualizzare sul controllo.

4. Selezionare grassetto, corsivo o sottolineato in FontSettings.

5. Selezionare i colori Background e Foreground richiesti in ColorSettings.

6. Per finire, fare clic sul segno di spunta vicino al pannello di controllo. 

La griglia delle proprietà viene chiusa.
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È possibile spostare il controllo trascinandolo in un'altra posizione sulla schermata. È anche possibile
ridimensionarlo trascinando i relativi angoli di ridimensionamento.

Proprietà

Proprietà Impostazione predefinita Descrizione

LabelContent Etichetta Il testo da visualizzare nel controllo.

FontSettings Grassetto, corsivo, sottolineato.

ColorSettings

Sfondo Colore sfondo del tema. Colore sfondo del controllo.

Primo piano Colore di primo piano del tema. Colore di primo piano del controllo.

Aggiunta di un controllo RunMacro
Utilizzare il controllo RunMacro per eseguire una macro.

1. Plus > Contenuti utente > Mostra/nascondi pannello di controllo . 

Il pannello di controllo viene visualizzato a destra di Rumba+ Desktop.

2. Trascinare il controllo RunMacro dal pannello di controllo nella posizione desiderata nella schermata. 

Sulla schermata viene visualizzata una griglia. Nel pannello di controllo viene visualizzata la griglia delle
proprietà RunMacro.

3. Immettere una didascalia per il controllo nel campo Caption.

4. Fare clic sul pulsante acceleratore vicino al file MacroFile.

5. Selezionare il file macro desiderato, quindi fare clic su Open.

6. Per finire, fare clic sul segno di spunta vicino al pannello di controllo. 

La griglia delle proprietà viene chiusa.

È possibile spostare il controllo trascinandolo in un'altra posizione sulla schermata. È anche possibile
ridimensionarlo trascinando i relativi angoli di ridimensionamento.

Proprietà

Proprietà Impostazione predefinita Descrizione

Caption Macro Il testo da visualizzare nel controllo.

MacroFile Consente di visualizzare il percorso
completo della macro selezionata.
Utilizzare il pulsante acceleratore per
selezionare la macro.

Modifica dei controlli
È possibile modificare i controlli aggiunti alla sessione Plus. Per eseguire questa operazione:

1. Fare clic con il pulsante destro del mouse e selezionare Edit dal menu a comparsa. 

Viene visualizzata la griglia delle proprietà per il controllo selezionato.

2. Apportare le modifiche desiderate, quindi fare clic sul segno di spunta vicino al pannello di controllo.

Informazioni sulla modalità di modifica

Quando la modalità di modifica è attivata:
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• È possibile spostare e ridimensionare i controlli, impostare o modificare la posizione di inserimento e
modificare le proprietà dei controlli.

• La griglia visualizzata sulla schermata semplifica il posizionamento e il ridimensionamento dei controlli.
• Quando si modifica un controllo, tutti gli altri controlli sulla schermata diventano grigi.
• Per ignorare tutte le modifiche, premere Esc oppure fare clic sulla x vicino al pannello di controllo.
• Se la schermata cambia, tutte le modifiche sono state ignorate.

Eliminazione dei controlli
Per eliminare un controllo, fare clic con il pulsante destro del mouse sul controllo e selezionare Delete dal
menu a comparsa.

Condivisione delle personalizzazioni
È possibile condividere le personalizzazioni delle schermate con altri utenti fornendo loro una copia di
Archivio Plus.

Ciascun personalizzazione delle schermate viene salvata automaticamente in un file denominato:

<nome_sessione>.rpar

dove <nome_sessione> è il nome della sessione host per la quale è stata creata la personalizzazione.

I file .rpar vengono memorizzati in %APPDATA%\Local\Micro Focus\Plus\Rules\

È possibile copiare i file in e da questa cartella. Ciò consente di utilizzarli con le sessioni host dallo stesso
nome.
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Contattare Micro Focus
Il nostro sito Web fornisce informazioni aggiornate su indirizzi e numeri di contatto.

Ulteriori informazioni e supporto dei prodotti
Ulteriori informazioni tecniche o consigli sono disponibili su varie fonti.

Le pagine di supporto dei prodotti contengono una notevole quantità di ulteriori informazioni, come:

• La sezione Product Updates del sito Web Micro FocusSupportLine da cui è possibile scaricare
correzioni e documenti aggiornati.

• La sezione Examples and Utilities del sito Web Micro FocusSupportLine che include demo e altri
documenti sui prodotti.

• La sezione Support Resources del sito Web Micro FocusSupportLine che include guide sulla
risoluzione dei problemi e informazioni su come segnalare un problema.

Per connettersi, accedere all'indirizzo https://www.microfocus.com/en-us/support dal browser.

Nota: Alcune informazioni potrebbero essere disponibili solo per i clienti che hanno sottoscritto un
contratto di manutenzione.

Se questo prodotto è stato ottenuto direttamente da Micro Focus, contattare l'azienda come indicato nel
sito Web Micro Focus all'indirizzo www.microfocus.com. Se il prodotto è stato ottenuto da un'altra fonte,
come un distributore autorizzato, si prega di contattare prima i diretti interessati per assistenza. Se non
sono in grado di fornire assistenza, si prega di contattare direttamente Micro Focus.

Inoltre, è possibile visitare:

• Il sito Web della comunità Micro Focus in cui è possibile consultare la knowledge base, leggere articoli
e blog, trovare esempi e programmi dimostrativi e parlare di questo prodotto con altri utenti ed esperti
Micro Focus.

• Il canale YouTube di Micro Focus per i video relativi al prodotto. .

Informazioni necessarie
Qualunque sia la modalità di contatto scelta, si prega di includere le informazioni riportate di seguito, se
disponibili. Più informazioni si possono fornire, migliore sarà l'assistenza fornita da Micro Focus
SupportLine. Tuttavia, se non si conoscono tutte le risposte o se si pensa che alcune risposte siano
irrilevanti per il problema in questione, si prega di fornire comunque le informazioni disponibili.

• Il nome e il numero della versione di tutti i prodotti che si pensa causino problemi.
• Marca e modello del computer.
• Il numero della versione del sistema operativo e dettagli sui software di rete eventualmente utilizzati.
• La quantità di memoria disponibile nel computer.
• La sezione o il riferimento della pagina rilevante presente nella documentazione.
• Il numero seriale. Per trovare questo numero, guardare nell'oggetto e nel corpo dell'e-mail Electronic

Product Delivery Notice ricevuta da Micro Focus.

Informazioni di contatto
Il nostro sito Web fornisce informazioni aggiornate su indirizzi e numeri di contatto.
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Ulteriori informazioni tecniche o consigli sono disponibili su varie fonti.

Le pagine di supporto dei prodotti contengono altre importanti informazioni, tra cui la sezione Product
Updates del sito Web di Micro FocusSupportLine, da cui è possibile scaricare correzioni e documenti
aggiornati. Passare alla sezione di aggiornamento prodotti di Micro Focus.

Per visitare la pagina, immettere l'indirizzo https://www.microfocus.com/en-us/home/ nel browser per
passare alla home page di Micro Focus, quindi fare clic su Supporto e servizi > Assistenza. Digitare o
selezionare il prodotto desiderato dall'elenco a discesa di selezione prodotti e fare clic su Accesso
assistenza.

I clienti di Micro FocusSupportLine possono consultare il documento Benvenuti nel servizio clienti che
include informazioni sul download e sulle licenze dei prodotti, su come contattare il servizio clienti e sulle
modalità di segnalazione di un problema. Il documento può essere scaricato dal sito Web di Micro Focus.
L'assistenza fornita da Micro Focus potrebbe essere disponibile solo per i clienti che hanno sottoscritto un
contratto di manutenzione.
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MICRO FOCUS END USER LICENSE
AGREEMENT

RUMBA+ DESKTOP v10.1
RUMBA FTP v4.8
ONWEB WEB-TO-HOST v6.9.3

IMPORTANT: LICENSOR IS PROVIDING THIS LICENSED SOFTWARE TO LICENSEE (THE ORIGINAL
PURCHASER EITHER AS AN INDIVIDUAL OR ON BEHALF OF ANOTHER LEGAL ENTITY AS ITS
EMPLOYEE OR AUTHORIZED AGENT) FOR ITS USE SUBJECT TO LICENSEE’S AGREEMENT TO
THE TERMS AND CONDITIONS SET FORTH BELOW. THESE TERMS AND CONDITIONS MAY BE
DIFFERENT FROM THE END USER LICENSE AGREEMENT(S) THAT ACCOMPANIED EARLIER
RELEASES OF THE LICENSED SOFTWARE. PLEASE READ THEM CAREFULLY TO ENSURE FULL
UNDERSTANDING BEFORE PROCEEDING, AS THEY MAY CONTAIN ADDITIONAL RESTRICTIONS
ON YOUR USE OF THE SOFTWARE. PLEASE DIRECT ANY QUESTIONS TO THE MICRO FOCUS
LEGAL DEPARTMENT AT LEGALDEPT@MICROFOCUS.COM. IF YOU DO NOT AGREE TO THE
TERMS AND CONDITIONS OF THIS LICENSE AGREEMENT, YOU WILL NOT BE AUTHORIZED TO
USE THE LICENSED SOFTWARE. BY CLICKING THE ACCEPT BUTTON OR SIMILAR ACCEPTANCE
MECHANISM DURING INSTALLATION, OR BY COPYING OR USING THE LICENSED SOFTWARE,
LICENSEE ACKNOWLEDGES THAT IT HAS READ THIS LICENSE AGREEMENT, UNDERSTOOD IT,
AND AGREED TO BE BOUND BY ITS TERMS AND CONDITIONS. THE LICENSED SOFTWARE IS
LICENSED NOT SOLD.

For this End User License Agreement (“License Agreement”) the following terms shall have the meanings
given below:

“Documentation” means the Licensor user documentation that is included with the Licensed Software.

“Licensee” means the single legal entity or person that rightfully acquires the Licensed Software from
Licensor or from a distributor or reseller of Licensor.

“License Options” means those license options set forth in Annex 1 to this License Agreement.

“Licensor” means the Micro Focus legal entity authorized to license the Licensed Software in the country
in which Licensee acquires the Licensed Software.

“Licensed Software” means the object code version of the Licensor computer program(s) listed above,
their Documentation, and other supplemental materials, as provided to Licensee by Licensor, including but
not limited to any software security keys relating thereto. The Documentation may be delivered
electronically and may only be available in the English language. The Licensed Software will be
accompanied by a license key where required for activation and use of the Licensed Software. The
Licensed Software shall also include, and this License Agreement shall govern the use of any update to the
Licensed Software that Licensee receives pursuant to a separate support and/or maintenance purchase as
described in Section 6 below, unless such update contains or comes with a different end user license
agreement, in which case such end user license agreement shall supersede this License Agreement and
govern the use of such software license without need for a mutually executed amendment to this License
Agreement as set forth in Section 17 of this License Agreement. This License Agreement does not grant
Licensee the right to any updates to the Licensed Software unless provided by Licensor under Section 6
and/or Section 7 below.

“Product Order” means a document that has been (i) executed by Licensee describing each Licensed
Software license to be purchased, and (ii) accepted by Licensor. Licensor will accept the Product Order by
either confirming Licensor’s acceptance in writing or by delivering the Licensed Software to Licensee,
whichever occurs first. A Product Order may also mean a written quote, or if referred to as such, a solution
order, issued by Licensor describing each Licensed Software license purchased that is accepted by
Licensee within the validity period of the quote either by Licensee executing and returning the quote or a
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solution order, to Licensor, by Licensee issuing a purchase order or other written confirmation of
acceptance to Licensor in conformance with the quote, and/or by Licensee paying to Licensor all fees set
forth in the quote. Each Product Order shall constitute a separate agreement and shall incorporate therein
this License Agreement. In the event of any conflict between the terms and conditions of this License
Agreement and the terms and conditions of any Product Order, the conflicting terms and conditions of the
Product Order shall govern. In no event shall any terms and conditions contained in a purchase order or
similar document issued by Licensee in connection with this License Agreement or with a Product Order
apply and any such document issued shall be only for the administrative purposes of identifying the
Licensed Software ordered, the number of licenses, and the price to be paid and shall have no other legal
effect. Licensor for purposes of this paragraph shall mean Licensor or, if applicable, one of Licensor’s
authorized resellers from whom Licensee purchases the Licensed Software, provided however that any
conflicting or additional terms in a Product Order accepted by an authorized reseller of Licensor shall have
no effect unless such terms have been agreed by Licensor in writing.

“Warranty Period” means a period of ninety (90) days from delivery of the Licensed Software to Licensee.

1. GRANT OF LICENSE; LICENSE CONDITIONS. For payment of the applicable non-refundable license
fees identified on the Product Order and subject to Licensee’s compliance with the terms and conditions
set forth in this License Agreement, Licensor grants solely to Licensee, as an end user, a personal,
perpetual (unless a subscription/term license has been purchased by Licensee), non-transferable, non-
sublicensable and non-exclusive license to use the Licensed Software solely for its own internal use
and benefit. Licensee’s use and operation of the Licensed Software and the license grant provided to
the Licensed Software is subject to Licensee being in possession of a valid license key where required
for the Licensed Software to run. Licensee agrees that Licensor is not liable or responsible for lost or
broken license keys or media or the provision of replacement license keys or media and/or new license
keys or media unless Licensee is current on support and maintenance for the applicable license and
then only to the extent set forth in the applicable annual support and/or maintenance agreement and
only to the extent Licensor then has sufficient rights from any applicable third party suppliers, if
necessary, to provide such replacement. If not current on support and maintenance for the applicable
license, replacement or new license keys or media may be available for purchase at Licensor’s then
current list fees for applicable new licenses.

Different License Options are available from Licensor as set forth or referred to in Annex 1. The
applicable License Option and license count to be purchased by Licensee for the Licensed Software
shall be identified in the Product Order or otherwise identified in writing by Licensor. Licensed Software
is also subject to additional terms and conditions as set forth in the “Specific Software Terms” located in
Annex 2. Any conflicting terms and conditions shall be resolved according to the following order of
precedence: Annex 2, Annex 1, and the main body of the License Agreement.

2. USE RESTRICTIONS. Except as may be otherwise specifically permitted in Annex 1 or Annex 2 to this
License Agreement, Licensee agrees not to:

2.1 Copy and/or distribute the Licensed Software, in whole or in part, for internal use without paying
Licensor the applicable additional fees required by Licensor, except (i) for making a reasonable
number of archival back-up copies; or (ii) as expressly authorized by Licensor in writing; or (iii) for
making a reasonable number of copies of the Documentation supplied to Licensee by Licensor in
electronic form. Licensee shall reproduce and affix all copyright and other proprietary rights notices
appearing in or on the Licensed Software, including notices of all third party suppliers.
2.2 Use the Licensed Software for timesharing, facilities management, outsourcing, hosting, service
bureau use, or for providing other application service (ASP) or data processing services to third
parties or for like purposes.
2.3 Modify the Licensed Software or provide any person with the means to do the same.
2.4 Create derivative works of the Licensed Software, or translate, disassemble, recompile or
reverse engineer the Licensed Software or attempt to do so (except to the extent applicable law
specifically permits such activity).
2.5 Alter, destroy, or otherwise remove any proprietary notices or labels on or embedded within the
Licensed Software or Documentation.
2.6 Use the Licensed Software in a manner other than as specifically permitted in this License
Agreement.
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3. AUDITS. Licensor or an Auditor (as defined below) has the right to verify Licensee’s compliance with
this License Agreement (and please see Micro Focus License Compliance Charter - http://
supportline.microfocus.com/licensing/licVerification.aspx). Licensee agrees to:

A. Implement internal safeguards to prevent any unauthorized copying, distribution, installation, or
use of, or access to, the Licensed Software and associated support and maintenance, or breach of
the terms or conditions of this License Agreement;
B. Take all necessary steps to destroy or erase all Licensed Software codes, programs and other
proprietary information before disposing of any media containing the Licensed Software;
C. Keep records sufficient to certify Licensee’s compliance with this License Agreement including
serial numbers and license keys of the Licensed Software, hypervisor logs where applicable, and the
location, model (including quantity and type of processor) and serial number of all machines on
which the Licensed Software is installed or from which the Licensed Software is accessed, and the
names (including corporate entity) and number of users that are accessing the Licensed Software,
and, upon request of Licensor, provide and certify metrics and/or reports based upon such records
and account for, among other things, numbers of copies (by product and version) and network
architectures as they may reasonably relate to Licensee’s licensing and deployment of the Licensed
Software and associated support and maintenance;
D. Upon Licensor’s request, Licensee shall furnish Licensor or an independent auditor chosen at
Licensor’s sole discretion (“Auditor”), within seven (7) days of the request, with a completed
questionnaire provided by Licensor or the Auditor, and with a written statement, in a format required
by Licensor, signed by a director of Licensee, certifying the accuracy of any information provided;
E. Allow a Licensor representative or an Auditor to inspect and audit Licensee’s computers and
records, during Licensee’s normal business hours, for compliance with the licensing terms for
Licensor’s software products and associated maintenance. Upon Licensor’s (and Auditor’s if
applicable) presentation of their signed written confidentiality statement form, Licensee shall fully
cooperate with such audit and provide any necessary assistance and access to records and
computers; and
F. In the event that Licensee has or at any time has had unlicensed installation, use of, or access to
the Licensed Software or has otherwise breached the license granted (a “Non-Compliance”), without
prejudice to any other rights or remedies Licensor may have, including without limitation injunctive
relief, Licensee shall, within thirty (30) days, purchase sufficient licenses and or subscriptions and
associated support and maintenance to cure the Non-Compliance, without benefit of any otherwise
applicable discount, by paying Licensor’s current (as of the date of such additional purchase) list
license fees and 12-month support and maintenance fees to Licensor for such additional licenses,
plus Licensor’s current (as of the date of such additional purchase) list term license and support and
maintenance fees and interest (compounded at 1.5% monthly or the maximum rate permitted by
applicable law if lower) for such additional licenses for the time period from the commencement of
the Non-Compliance until payment of the aforementioned fees. The aforementioned interest shall be
payable even if an invoice was not issued at the time the Non-Compliance commenced. If a material
license shortfall of 5% or more is found, Licensee shall also reimburse Licensor for the reasonable
cost of such audit in addition to other amounts due. The obligations in this Section 3 shall apply to
both Licensee’s Non-Compliance and any third party’s Non-Compliance.

4. DOCUMENTATION. One (1) electronic copy of Licensor’s standard Documentation, describing
Licensor’s recommended use and application of the Licensed Software, will be furnished or made
available on Licensor’s website free of additional charge to Licensee by Licensor with the Licensed
Software. Printed copies of any Documentation may be available for purchase from Licensor or its
authorized distributors. Additional copies of standard Documentation may be available on Licensor’s
website.

5. TERM OF LICENSE. This License Agreement and Licensee’s license for the Licensed Software is
perpetual, unless a subscription/term license has been purchased by Licensee (in which case the term
of the license shall be as set forth in the Product Order, specified in Annex 1 or Annex 2, or as
otherwise agreed in writing between the Licensee and Licensor), and is subject to earlier termination as
provided in this Section 5. If Licensee has purchased a subscription/term license, Licensee’s license to
the Licensed Software shall automatically terminate upon expiry of such subscription/term. Licensor
may terminate this License Agreement and Licensee’s license to the Licensed Software immediately by
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giving Licensee written notice of termination in the event that either (i) Licensee breaches any term or
condition of this License Agreement and Licensee has failed to remedy such breach within ten (10)
days of the date of notice from Licensor to Licensee or (ii) Licensee is wound up, has a receiver
appointed or has applied for or enters into liquidation or bankruptcy or analogous process or processes.
Termination shall be without prejudice to any other rights or remedies Licensor may have. In the event
of any termination Licensee will have no right to keep, access, or use the Licensed Software or any
copy of the Licensed Software for any purpose and Licensee shall destroy and erase all copies of such
Licensed Software in its possession or control, and forward written certification to Licensor that all such
copies of Licensed Software have been destroyed or erased. Termination shall not entitle the Licensee
to any refund or reimbursement of any kind of previously paid fees. The rights and obligations of the
parties contained in Sections 3, 8, 9, 10, 11, 12, and 13, and other sections that by their nature are
intended to survive, will survive the termination or expiration of this License Agreement.

6. SUPPORT AND MAINTENANCE. Where Licensee purchases support and/or maintenance services,
Licensee’s initial support and/or maintenance term will begin upon delivery to Licensee of the Licensed
Software and continue for one (1) year thereafter (or the length of the term if less than a year for any
subscription/term license) unless otherwise specified in the applicable annual support and/or
maintenance agreement, Product Order, or other written agreement executed between Licensor and
Licensee. Where Licensee purchases support and/or maintenance for any Licensed Software, Licensee
hereby agrees that it shall purchase such support and/or maintenance services for all of Licensee’s
licensed units of such Licensed Software product. Support and/or maintenance services provided by
Licensor will be subject to Licensor’s then current applicable standard annual support and/or
maintenance agreement unless otherwise agreed by the parties in writing.

7. LIMITED WARRANTY. Licensor warrants for the Warranty Period (i) that if the Licensed Software is
supplied via media, then the media will be free from defects in materials or workmanship under normal
use and (ii) that the copy of the Licensed Software delivered to Licensee conforms in all material
respects to the Documentation. As the sole and exclusive remedy for not meeting part (i) of the above
warranty, Licensor’s sole obligation shall be to repair or replace free of charge any defective media on
which the Licensed Software is delivered if the media is returned to Licensor by Licensee during the
Warranty Period. As the sole and exclusive remedy for not meeting part (ii) of the above warranty,
Licensor shall repair or replace the Licensed Software free of charge so that it conforms with the
warranty or, if Licensor reasonably determines that such remedy is not economically or technically
feasible, Licensee shall be entitled to a full refund of the license fee and any maintenance fee paid by
Licensee with respect to that particular Licensed Software. Upon such refund Licensee’s license to use
such Licensed Software will terminate. The warranty set forth in this Section 7 shall not apply if the
defect in the Licensed Software is the result of: (a) the Licensed Software not being used in accordance
with the Documentation, this License Agreement or with the platform(s) for which the Licensed Software
has been designed and licensed by Licensor; or (b) the Licensed Software having been altered,
modified or converted by Licensee or any third party except as may be specified in the Documentation;
or (c) the malfunctioning of Licensee’s equipment; or (d) accident or abuse; or (e) service by any
unauthorized person; or (f) other software used by Licensee which has not been provided by Licensor
or for which the Licensed Software is not designed and licensed for operation; or (g) Third Party
Software (as defined herein); or (h) any other cause occurring after initial delivery of the media to
Licensee unless caused directly by Licensor. The foregoing states the complete and entire remedies
that Licensee has under this warranty. Licensor shall have no responsibility for any warranty claims
made outside of the Warranty Period. The foregoing warranty shall not apply to any free-of-charge
Licensed Software including updates, though issues with such software may be eligible for support
under applicable support terms and conditions.

8. DISCLAIMER OF WARRANTY. The Licensed Software cannot be tested in every possible operating
environment, therefore Licensor does not warrant that the functions contained in the Licensed Software
will meet Licensee’s requirements, that operation of the Licensed Software will be uninterrupted, or that
the Licensed Software is error free. EXCEPT AS SET FORTH HEREIN AND TO THE EXTENT
PERMITTED BY LAW, ALL OTHER WARRANTIES, EXPRESSED OR IMPLIED, STATUTORY OR
OTHERWISE, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY,
QUALITY AND FITNESS FOR A PARTICULAR PURPOSE, ARE EXCLUDED ON THE PART OF
LICENSOR AND ITS THIRD-PARTY SUPPLIERS. Licensee acknowledges that Licensee is responsible
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for the selection of the Licensed Software to achieve Licensee’s intended results and for the installation
and/or use of, and results obtained from, the Licensed Software.

9. LIMITATION OF LIABILITY. ANY LIABILITY OF LICENSOR SHALL BE LIMITED IN THE
AGGREGATE TO THE AMOUNTS PAID BY LICENSEE FOR THE LICENSED SOFTWARE GIVING
RISE TO THE APPLICABLE CLAIM. THIS LIMITATION APPLIES TO ALL CAUSES OF ACTION,
INCLUDING WITHOUT LIMITATION BREACH OF CONTRACT, BREACH OF WARRANTY,
NEGLIGENCE, STRICT LIABILITY, MISREPRESENTATION AND OTHER TORTS. IN NO EVENT
SHALL LICENSOR BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL,
PUNITIVE OR SIMILAR DAMAGES NOR FOR ANY LOSS OF PROFITS, CONTRACTS, DATA, OR
PROGRAMS, OR THE COST OF RECOVERING SUCH DATA OR PROGRAMS, EVEN IF INFORMED
OF THE POSSIBILITY OF SUCH DAMAGES IN ADVANCE. LICENSOR’S LIMITATIONS OF LIABILITY
ARE NOT CUMULATIVE. LICENSEE’S REMEDIES IN THIS LICENSE AGREEMENT ARE
LICENSEE’S EXCLUSIVE REMEDIES.

NONE OF LICENSOR’S THIRD-PARTY SUPPLIERS SHALL BE LIABLE FOR ANY INJURY, LOSS OR
DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL NOR FOR
ANY LOSS OF PROFITS, CONTRACTS, DATA, OR PROGRAMS, OR THE COST OF RECOVERING
SUCH DATA OR PROGRAMS, EVEN IF INFORMED OF THE POSSIBILITY OF SUCH DAMAGES IN
ADVANCE.

LICENSEE AGREES THAT, IN ENTERING INTO THIS LICENSE AGREEMENT, EITHER IT DID NOT
RELY ON ANY REPRESENTATIONS (WHETHER WRITTEN OR ORAL) OF ANY KIND OTHER THAN
THOSE EXPRESSLY SET OUT IN THIS LICENSE AGREEMENT, OR IF IT DID RELY ON ANY
REPRESENTATIONS, THAT IT SHALL HAVE NO REMEDY AGAINST LICENSOR IN RESPECT OF
SUCH REPRESENTATIONS.

LICENSEE FURTHER ACKNOWLEDGES THAT THE LIMITATIONS OF LIABILITY IN THIS SECTION
ARE AN ESSENTIAL ELEMENT OF THIS LICENSE AGREEMENT AND THAT, IN THE ABSENCE OF
SUCH LIMITATIONS, THE PRICING AND OTHER TERMS AND CONDITIONS SET FORTH HEREIN
WOULD BE SUBSTANTIALLY DIFFERENT.

NEITHER THIS LICENSE AGREEMENT NOR ANYTHING IN THIS SECTION 9 SHALL EXCLUDE OR
RESTRICT THE LIABILITY OF LICENSOR OR ITS THIRD-PARTY SUPPLIERS TO ANY EXTENT
NOT PERMITTED BY LAW.

10.HIGH-RISK USES. The Licensed Software is not fault tolerant, nor designed, manufactured or intended
for use in hazardous environments requiring fail-safe performance (including, without limitation, the
operation of nuclear facilities, aircraft navigation or communication systems, air traffic control, direct life
support machines, or weapons systems) in which failure of the Licensed Software could lead directly or
indirectly to death, personal injury or severe physical or environmental damage. Licensor and its
suppliers shall have no liability for any use of the Licensed Software in any high-risk situations.

11.OWNERSHIP. Licensor (or its affiliates) and where applicable Licensor’s third party suppliers have and
will retain all ownership rights to the Licensed Software, together with any complete or partial copies
thereof. Such ownership rights include without limitation all patent rights, copyrights, trademarks, trade
secrets, service marks, related goodwill, and confidential and proprietary information relating thereto.
This License Agreement does not convey any proprietary interest to Licensee with respect to the
Licensed Software other than the license specified herein.

12.THIRD PARTY SOFTWARE AND COMPONENTS. The Licensed Software may come with and/or
require certain named third party software programs that Licensee shall license directly from the third
party subject to such third party’s terms and conditions (for example Adobe Acrobat or Microsoft
Internet Explorer) (“Third Party Software”). Any Third Party Software is provided by the licensor of the
Third Party Software solely under a direct license between such third party and Licensee under such
third party’s terms and conditions. Therefore the obligations, duties and rights of Licensor and Licensee
under this License Agreement do not apply to such Third Party Software. Additionally, Licensor has
embedded in some Licensed Software certain run time or other elements provided by third party
suppliers to Licensor (“Third Party Components”). Such Third Party Components may also be loaded on
the Licensed Software media. Third Party Components are licensed to Licensee pursuant to this
License Agreement. Third Party Components may also include open source software, details of which
(where applicable) may be found (i) in a file accompanying the applicable Licensed Software or (ii) in the

MICRO FOCUS END USER LICENSE AGREEMENT | 115



applicable Documentation. Licensee may only access Third Party Components of the Licensed
Software in the course of using the Licensed Software. Licensee may not make or attempt any direct
access to any such Third Party Components other than with the Licensed Software. All limitations,
restrictions and obligations applicable to the Licensed Software set forth in this License Agreement shall
apply to Licensee’s use of the Third Party Components. The Third Party Software and Third Party
Components are the property of its respective third party supplier to Licensor. Such third party suppliers
own all copies of the Third Party Software and Third Party Components, however made. Licensee
agrees not to contest the ownership of the Third Party Software and Third Party Components nor use
any trademark or service mark belonging to such third party suppliers. Licensee agrees that such third
party suppliers are intended third party beneficiaries of all terms and conditions of this License
Agreement intended to protect intellectual property rights in the Licensed Software (including the Third
Party Components) and limit certain uses thereof. Nothing in this License Agreement shall restrict, limit
or otherwise affect any rights or obligations Licensee may have, or conditions to which Licensee may be
subject, under any applicable open source licenses to any open source code contained in the Licensed
Software.

13.NOTICE TO U.S. GOVERNMENT END USERS. The Licensed Software and Documentation are
deemed to be “Commercial Items,” as defined at 48 C.F.R. §2.101, consisting of “Commercial Computer
Software” and “Commercial Computer Software Documentation,” as such terms are used in 48 C.F.R.
§12.212 or 48 C.F.R. §227.7207, as applicable. Consistent with such sections, the Licensed Software
and Documentation are licensed to U.S. Government end users (i) only as Commercial Items, and (ii)
with only those rights as are granted pursuant to this License Agreement. Manufacturer is Micro Focus
(US), Inc., 700 King Farm Blvd., Suite 125, Rockville, MD 20850 as or on behalf of Licensor.

14.LICENSE FEES AND PAYMENT TERMS. Licensee agrees to pay the applicable end user license fees
for the Licensed Software within thirty (30) days of the date of invoice or such other date as agreed in
writing by the parties. End user license fees are non-refundable except as provided in Section 7 above,
or in the Specific Software Terms below, and shall be paid without deduction, including without
limitation, of any withholding tax. End user license fees are exclusive of any applicable transportation
charges, value added and other applicable taxes and duties and all such amounts shall be paid or
reimbursed by Licensee. Outstanding past-due amounts shall accrue interest at the rate of 1.5% per
month compounded or, if lower, the maximum rate allowed by applicable law. Licensee shall be liable for
any such interest and all related collection costs, whether or not an action has been filed. Licensor may
decline to enter into any additional Product Orders if any such past-due balance, interest and collection
costs are not paid.

15.RELATED SERVICES. Licensee shall be responsible for obtaining and installing all proper hardware
and support software (including operating systems) and for proper installation and implementation of
and training concerning the Licensed Software. In the event that Licensee retains Licensor to perform
any services with respect to the Licensed Software (for example: installation, implementation,
maintenance, consulting and/or training services), Licensee and Licensor agree that such services shall
be subject to Licensor’s then current standard terms, conditions and rates for such services unless
otherwise agreed in writing by Licensor.

16.PRIVACY. If the Licensed Software contains features that may allow Licensee to collect data from,
control and/or monitor computers running the Licensed Software deployed by Licensee without notice to
or knowledge by users of the Licensed Software, then: (i) Licensee is solely responsible for, and
assumes all liability with respect to, the collection of data with respect to its users of the Licensed
Software including, without limitation, notifying such users and complying with all data collection, privacy
and other regulations, laws, industry standards and rights of others applicable to any such activity; and
(ii) Licensee shall indemnify and hold Licensor harmless from and against any damages, claims, losses,
settlements, attorneys' fees, legal fees and court costs and other expenses related to any such activities
or any claims in connection therewith. To the extent permitted by law, by entering into this License
Agreement, Licensee hereby expressly consents to (i) Licensor sending information to Licensee from
time to time advertising the various products that Licensor provides, whether or not such products are
provided under this License Agreement; (ii) the use of Licensee’s name in Licensor customer lists,
promotional materials and/or press releases; and (iii) the collection and use by Licensor of information
about the computer system on which the Licensed Software is installed (e.g. product version, serial
number) for internal security and licensing purposes; Licensor does not use this information to identify
individuals utilizing such software.
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17.MISCELLANEOUS. Licensor may assign this License Agreement (in whole or in part) to any member of
Licensor’s group of companies or to a purchaser of the intellectual property rights in the Licensed
Software, but otherwise neither this License Agreement nor any rights hereunder may be assigned (any
change of control merger, sale or other transfer of all, or substantially all, of the assets of Licensee shall
be included in the meaning of an assignment) nor duties delegated by either party, and any attempt to
do so will be void.

If Licensee acquires the Licensed Software in North America, the laws of the state of Maryland govern
this License Agreement and the licenses granted hereunder and the parties hereto consent and agree
that they shall be subject to the exclusive jurisdiction of the State and/or Federal courts sitting in the
State of Maryland in any action based on this License Agreement or concerning the licenses granted, or
the products licensed, hereunder. Each party waives any right it may have to object to such venue,
including objections based on personal jurisdiction or forum non conveniens (inconvenient forum). The
parties agree that the Uniform Computer Information Transaction Act or any version thereof, adopted by
any state, in any form ("UCITA"), shall not apply to this License Agreement. To the extent that UCITA is
applicable, the parties hereby opt out of the applicability of UCITA pursuant to the opt-out provision(s)
contained therein. If Licensee acquires the Licensed Software in France, Germany or Japan, this
License Agreement is governed by the laws of the country in which Licensee acquired the Licensed
Software. In the rest of the world the laws of England govern this License Agreement. The aforesaid
applicable law shall apply without regard to conflicts of laws provisions thereof, and without regard to
the United Nations Convention on the International Sale of Goods. Other than for North American
transactions, this License Agreement, the licenses granted hereunder, and the parties hereto, shall be
subject to the exclusive jurisdiction of the courts of the country determining the applicable law as
aforesaid. In the event of a dispute, the prevailing party shall have the right to collect from the other
party its reasonable costs and necessary disbursements and attorneys' fees incurred in enforcing this
License Agreement.

This License Agreement is in addition subject to any United States, United Kingdom or European Union
laws, regulations and other restrictions regarding export or re-export of computer software and
technology. Licensee agrees not to export or re-export any Licensed Software or derivative thereof in
contradiction to any such applicable restriction. In particular but without limitation, Licensee
acknowledges that Licensor’s products and/or technology are subject to the U.S. Export Administration
Regulations (the “EAR”) and Licensee agrees to comply with the EAR. Licensee will not export or re-
export Licensor’s products, directly or indirectly, to: (1) any countries that are subject to US or applicable
export restrictions; (2) any end user who Licensee knows or has reason to know will utilize Licensor’s
products in the design, development or production of nuclear, chemical or biological weapons, or rocket
systems, space launch vehicles, and sounding rockets, or unmanned air vehicle systems; or (3) any end
user who has been prohibited from participating in export transactions by any applicable agency of
government. By downloading or using the Licensed Software, Licensee is agreeing to the foregoing and
Licensee is representing and warranting that Licensee is not located in, under the control of, or a
national or resident of any such country or on any such list.

Licensor may identify Licensee by name and/or logo as a licensee of Licensor for investor relations,
analyst relations, and public relations purposes, and in online and printed sales and marketing
materials. Any other use of Licensee’s name or logo, or a description of Licensee’s use of the Licensed
Software, shall be subject to Licensee’s prior consent. Within eight (8) weeks after installation of the
Licensed Software, upon Licensor’s written request Licensee will provide Licensor with input to a written
description of Licensee’s use of the Licensed Software including details of the business challenge,
software solution, and results realised from the installation of the Licensed Software. The input shall be
provided by a representative of Licensee (who is knowledgeable of the Licensed Software and its
performance after installation) during a meeting with a representative of Licensor (at a reasonable time
to be agreed by the parties). The meeting may be conducted by telephone. This input may be used
internally within Licensor and in confidential sales situations. Any other use of this input shall be subject
to Licensee’s prior consent.

Except for the Product Order, this License Agreement is the complete and exclusive statement of
agreement between the parties relating to the license for the Licensed Software and supersedes all
proposals, communications, purchase orders, and prior agreements, verbal or written, including without
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limitation prior end user license agreements in relation to the Licensed Software between the parties
and end user license agreements embedded in such Licensed Software. No employee, agent, or
representative of Licensor has the authority to bind Licensor to any oral representation or warranty
concerning the Licensed Software. No representation or statement not expressly contained in this
License Agreement nor any supplement, modification, or amendment of this License Agreement will be
binding on either party unless executed in writing by a duly authorized representative of Licensor and
Licensee (excluding any distributor or reseller of Licensor) to this License Agreement. No waiver of any
right under this License Agreement will be effective unless in writing, signed by a duly authorized
representative of the party to be bound (excluding any distributor or reseller of Licensor). No waiver of
any past or present right arising from any breach or failure to perform will be deemed to be a waiver of
any future right arising under this License Agreement. If any provision in this License Agreement is
invalid or unenforceable, that provision will be construed, limited, modified or, if necessary, severed, to
the extent necessary, to eliminate its invalidity or unenforceability, and the other provisions of this
License Agreement will remain unaffected. Each party acknowledges that in entering into this License
Agreement it has not relied on any representations, agreements, warranties or other assurances (other
than those repeated in this License Agreement and the Product Order) and waives all rights and
remedies which but for this section 17 would be available to it. Nothing in this section 17 excludes
liability for fraudulent misrepresentation.

If Licensee is situated in Italy, by placing or executing a Product Order, Licensee declares to have read
and to have explicitly approved the following clauses of the License Agreement: 5. Term of License, 6.
Support and Maintenance, 7. Limited Warranty, 8. Disclaimer of Warranty, 9. Limitation of Liability, 10.
High-Risk Uses, 16. Privacy, 17. Miscellaneous, Annex 1, and Annex 2.

ANNEX 1, LICENSE OPTIONS

DEFINITIONS

For this License Agreement, the following additional definitions shall apply:

“Desktop Container” means an isolated, resource controlled, and portable runtime environment which
runs on a host machine or Virtual Machine.

“Hard Partitioning” means using hard physical partitioning to physically segment a single larger server or
machine into separate and distinct smaller systems where each separate system acts as a physically
independent, self-contained server or machine with its own CPUs, operating system, separate boot area,
memory, input/output subsystem and network resources (each known as a “Hard Partition”). Examples of
Hard Partitioning methods include: Dynamic System Domains (DSD) -- enabled by Dynamic
Reconfiguration (DR), Solaris Zones (also known as Solaris Containers, capped Zones/Containers only),
LPAR (adds DLPAR with AIX 5.2), Micro-Partitions (capped partitions only), vPar, nPar, Integrity Virtual
Machine (capped partitions only), Secure Resource Partitions (capped partitions only), and Fujitsu’s PPAR.

“Platform” means a hardware chipset (e.g., PA-RISC, Itanium, x86, or SPARC) and operating system
(e.g., Windows, Linux, Solaris, AIX, or HP-UX) combination.

“Soft Partitioning” means using an operating system resource manager to segment and limit the number
of Cores, CPUs, or other processing devices utilized by the Licensed Software by creating areas where
processor resources are allocated and limited within the same operating system (each such area known as
a “Soft Partition”). Examples of such Soft Partitioning include: Solaris 9 Resource Containers, AIX
Workload Manager, HP Process Resource Manager, Affinity Management, Oracle VM, and VMware.

“Update” means the definition for such term set forth in Licensor’s then current applicable standard annual
support and/or maintenance agreement.

“Upgrade” means any change in the licensed Platform for the Licensed Software or a successor product
to the Licensed Software.

“Virtual Desktop Infrastructure” means a desktop virtualization approach where the desktop operating
system runs and is managed in a separate server instead of the client device. The desktop image is
delivered over a network to an endpoint device, which allows the user to interact with the operating system
and its applications as if they were running locally.
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“Virtual Machine” means a software implementation that can run its own operating system and execute
programs like a physical machine where the software running inside the virtual machine is limited to the
resources and abstractions provided by the virtual machine.

LICENSE OPTIONS

The following license types apply to Licensee’s installation and use of the Licensed Software depending on
which type of product licenses Licensee has purchased as set forth in the applicable Product Order.
Licensee may only apply one license type to a deployment.

1. Workstation, Authorized User, or Basic PC License Licensed Software provided under this License
Option gives Licensee the right to install and use one copy of the Licensed Software on one stand-alone
workstation or device per license. Licensee may not (i) install the Licensed Software on any networked
workstation or device (e.g., a server) that allows more than one user to use a copy of the Licensed
Software, (ii) use the Licensed Software in a Windows Terminal Services, Citrix Server, Virtual Desktop
Infrastructure, Desktop Container, or similar environment, or (iii) use the Licensed Software other than
on one stand-alone workstation or device at a time. The foregoing shall not prohibit installation and use
of the Licensed Software in one Virtual Machine per license provided such Virtual Machine is running
on one stand-alone workstation or device and is not connected to or running in a Windows Terminal
Services, Citrix Server, Virtual Desktop Infrastructure, Desktop Container, or similar environment.
Licensee may transfer the Licensed Software to another stand-alone workstation or device and
reactivate it for use on such other stand-alone workstation or device provided that the Licensed
Software is removed and all copies of it are deleted from the stand-alone workstation or device from
which it is transferred. Such transfers may not be undertaken more often than once every 30 days. A
license must be purchased (i) for each device (including Virtual Machines and portable-storage devices)
on which the Licensed Software or any component of the Licensed Software is installed or loaded in the
permanent or temporary memory of the device and (ii) for each additional end-user device (including
Virtual Machines) through which a copy of the Licensed Software could be accessed for interactive use,
regardless of use case including production, test, or disaster recovery.

This license type does not permit the usage models (among others) commonly known as
concurrent use or common image with activation.

2. Processor License Licensed Software provided under this License Option gives Licensee the right to
install the Licensed Software on any number of devices, workstations, or servers (and connect any
number of clients to such servers) for connection to a single Hard Partition or Soft Partition on a host
system with the same type of processor specified for the license in the applicable Product Order (e.g.,
P10, P40, etc.).

3. Concurrent User License Licensed Software provided under this License Option gives Licensee the
right to install and use one copy of the Licensed Software on multiple devices, workstations, or servers
for use by up to the maximum number of Concurrent Users set forth in the applicable Product Order for
whom Licensee has paid the applicable license fee. Concurrent Users are individuals who are actively
using any device or other software program that may access the Licensed Software either directly, or
indirectly through any other software program, regardless of how such access occurs or if such user
uses any hardware or software that reduces the apparent number of users who are using the Licensed
Software, such as by using a terminal service. Licensee may connect any number of workstations and
clients to the server(s); however, the total number of users who may access and use the Licensed
Software at any given time is limited by the number of Concurrent Users expressly authorized by
Licensor in the Product Order. Licensee must employ a method to control, monitor, and provide reports
on concurrent usage, either by (i) using the Licensed Software in a Windows Terminal Services
(sometimes referred to as “multi-user Windows”, “WTS”, or “Citrix Server”) environment that is
configured to control, monitor, and provide reports on concurrent usage, (ii) using the Licensed
Software’s Management and Security Server metering tool (or a tool that will provide equivalent data) to
control, monitor, and provide reports on concurrent usage, or (iii) using another method approved by
Licensor in writing to control, monitor, and report on such usage. Licensee agrees that should Licensee
fail to comply with the foregoing, then without prejudice to any remedies available to Licensor, the
licensing basis for the Licensed Software shall automatically revert to Workstation licensing at a ratio of
1:1 (i.e., one Concurrent User license will be converted to one Workstation license) commencing from
the start of Licensee’s failure to comply.
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4. Named User License Licensed Software provided under this License Option gives Licensee the right to
install and use one copy of the Licensed Software on multiple devices, workstations, or servers for use
by up to the maximum number of named users set forth in the applicable Product Order for whom
Licensee has paid the applicable license fee. A named user license must be purchased for each person
who is able to access or use the Licensed Software. Licensee must monitor and control deployment so
that all access to the Licensed Software is restricted to persons having a dedicated named user license.
Named user licenses will be reassigned to other persons only in association with changes in staffing
and/or business operations that are intended to be permanent, and all Licensed Software access
available to the previous assignees will be effectively terminated. A named user license: (i) is not a
concurrent-user license; and (ii) does not permit operation of the Licensed Software as middleware.
Prohibition of operation as middleware means that the Licensed Software may not be deployed for the
purpose of providing automated, unattended communications and/or services to other applications or
devices.

Unless Licensee has obtained Licensor’s prior written approval to use another method to control,
monitor, and report on its named users’ access to the Licensed Software, Licensee shall use Microsoft’s
Active Directory Users and Computers utility, together with the Citrix Access Management Console, to
define user-based access control to the Licensed Software (which may be referred to by the vendors as
“the application”). Within the Citrix Access Management Console, use of the Citrix User Selector and/or
Citrix Access Gateway is allowed, as is direct integration with Microsoft Active Directory as the Directory
Type. Licensee cannot use the “allow anonymous users” setting in Citrix in configuring access to the
Licensed Software application. That is, access to the Licensed Software application must be configured
using “Explicit Users” and not “Anonymous Users.” For additional details on how to grant application
access to “Explicit Users,” please refer to the Citrix Administration documentation on Managing Delivery
Options for Published Resources. Licensee’s network architecture and controls must effectively block
any network path to the Licensed Software that is not managed by the control mechanisms described in
this paragraph.

With respect to its named user licenses, Licensee shall create quarterly reports including data and
analysis materials as detailed below:

Data: The report must show all users and all groups who have had access to the Licensed Software
in the reported quarter (regardless of whether or not they did access the Licensed Software). The
report must provide details of the registered user ID’s and for each the associated user name(s) and
the Licensed Software products the user is able to access (identified by product name and version).
The report must also include full detail of each user permission activation or de-activation event
during the quarter. The report must also show all devices having a copy of the Licensed Software,
and for each such device, all persons having access to the device.
Analysis: Licensee must analyze its own data and include the following materials as part of the
report: (i) High-water count of individuals whose network permissions, or desktop-copy availability,
would have allowed them access to the Licensed Software on any given day within the quarter. (ii)
Explanation of the sources of any reported data not naturally obtained from the defined controls. (iii)
Explanation of the logic applied to the raw data to support the conclusions above.
General: Licensee will retain quarterly reports for a period of four years, and will make the reports
available to Licensor on request. The data portion of the report must be made available in Excel
spreadsheet form.Licensee agrees that should Licensee fail to comply with the foregoing, then
without prejudice to any remedies available to Licensor, the licensing basis for the Licensed Software
shall automatically revert to Workstation licensing at a ratio of 1:1 (i.e., one Named User license will
be converted to one Workstation license) commencing from the start of Licensee’s failure to comply.

5. Robotic Process Automation License Licensed Software provided under this License Option gives
Licensee the right to install and use one copy of the Licensed Software in a fully automated, unattended
scenario (with no human end-user) where a Robotic Process Automation (RPA) tool is leveraging the
Licensed Software’s automation interfaces (HLLAPI, VBA, .NET) to scrape data from a host/mainframe
screen and then use this host data as the RPA tool orchestrates the exchange of data between various
applications to automate a business process. No support is available for developing the automated
application. The Licensed Software is intended for smaller scale applications and, hence, limited to a
reasonable load being placed upon the client or server device.
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6. Middleware License Licensed Software provided under this License Option gives Licensee the right to
install and use one copy of the Licensed Software solely for the purpose of providing automated,
unattended communications and/or services to other applications or devices. This includes use of the
Licensed Software as a Print Server. "Print Server" means a device with Licensed Software installed
that is running multiple host printer emulation sessions to service print jobs from multiple terminal
emulation sessions not concurrently running on that same device running the printer sessions (and,
hence serving as a Print Server).

ANNEX 2, SPECIFIC SOFTWARE TERMS

Additional Restrictions. Licensee agrees not to:

1. Copy and/or distribute the Licensed Software, in whole or in part, to third parties, or use the Licensed
Software for the benefit of any third party, or permit use or access by any third party to all or part of the
Licensed Software without first paying Licensor any applicable additional fees required by Licensor and
entering into a separate distribution license agreement with Licensor. For the avoidance of doubt, third
party(ies) include without limitation contractors, outsourcers, Licensee’s customers and the public.

2. Transfer, ship or use the Licensed Software outside the continent in which it was originally licensed to
Licensee without first paying Licensor any applicable additional fees required by Licensor. For purposes
of the foregoing, “continent” shall mean North America, South America, Europe, Africa, Asia, Australia,
or Antarctica.

3. Install, access or use the Licensed Software on a Platform other than the Platform for which the
Licensed Software was originally licensed to Licensee. Additional licenses for use of the Licensed
Software on a Platform other than the one set forth in the applicable Product Order may be available
upon payment of an additional license fee.

4. Assign, sell, rent, lease, lend, sublicense, outsource or otherwise transfer the Licensed Software to any
third party, or authorize or appoint any third party to do so, or otherwise allow a third party to directly or
indirectly use or access the Licensed Software, without Licensee first paying Licensor the applicable
additional fees required by Licensor.

Developer License. In the event the Product Order specifies the license as a Developer license, such
license shall be equivalent to a Workstation License as set forth in Annex 1.

Host Restriction. In the event the Product Order specifies a type of host system (e.g, Mainframe, UNIX,
AS/400), Licensee may connect the Licensed Software only to host systems that are the same as the type
specified.

Middleware & Robotic Process Automation. Except as specifically stated above for a Robotic
Process Automation License and Middleware License, none of the license types set forth in this
License Agreement permit operation of the Licensed Software with Robotic Process Automation or
as middleware. Prohibition of operation as middleware means that the Licensed Software may not
be deployed for the purpose of providing automated, unattended communications and/or services
to other applications or devices. By way of example only and without limitation, this restriction
expressly prohibits use of the Licensed Software as a Print Server.

Evaluation License. An evaluation license gives Licensee a term license to use the Licensed Software
within Licensee during the evaluation term specified in writing by Licensor, solely for evaluation and testing
purposes on a single computer system and not for development, commercial, or production purposes.
Licensee may not reproduce or distribute the Licensed Software. Licensee’s results of benchmark or other
performance tests run on or using the Licensed Software may not be disclosed to any third party without
Licensor’s prior written consent. At any time during the evaluation term or upon completion thereof,
Licensee may, upon written notification to Licensor and payment of the applicable license fee, replace the
evaluation license with a license to use the Licensed Software pursuant to one of the other applicable
options listed in Annex 1. In the absence of such notification by Licensee, the evaluation license shall
automatically terminate at the end of the evaluation term and Licensee shall return, or, if Licensor so
directs, delete and destroy all such Licensed Software and provide Licensor with written confirmation of
such deletion and destruction being completed. Licensor may, in its sole discretion, grant Licensee an
extension to the evaluation term subject to receiving a written request and reasons for such request from
Licensee prior to expiration of the evaluation term. Licensor will specify any such agreed extension in
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writing to Licensee. Licensed Software provided by Licensor free of license fee charge shall be deemed to
be an evaluation license unless otherwise agreed in writing. In the absence of any contrary period specified
in writing by Licensor, the evaluation term shall be deemed to be thirty (30) days. In relation to any
evaluation license, this section shall prevail over any contrary provisions set forth in this License
Agreement.

All-or-None Support and Maintenance. Where Licensee purchases support and/or maintenance for the
Licensed Software, Licensee hereby agrees that it shall purchase such support and/or maintenance
services for all of Licensee’s licensed units of such Licensed Software including all related development
and deployment product licenses.

Updates and Upgrades. Upon delivery to Licensee of any Update and/or Upgrade, the license granted to
such prior version and/or release being updated or upgraded shall terminate after a ninety (90) day
transition period from such delivery and only the license to such Update or Upgrade shall continue unless
(i) Licensee has paid to Licensor the applicable additional fees required by Licensor to use both versions,
or (ii) in the case of an Update that is provided to Licensee at no additional charge from Licensor pursuant
to support and/or maintenance for which Licensee has separately contracted, Licensee provides written
notice to Licensor during the aforementioned transition period of its election not to use the Update but
instead remain with the prior version and Licensee’s de-installation and destruction of such Update.

Bundles/Suites. If the Licensed Software is licensed as part of a bundle or suite of multiple products, and
the applicable Product Order specifies the License Option and license count for the bundle or suite (but not
the individual product components of the bundle or suite), then each product in the suite or bundle shall
share such license type and count. Individual products in the bundle or suite cannot be used by multiple
users if only one user license is purchased (for user-based licenses) and cannot be installed on multiple
workstations if only one workstation license is purchased (for workstation licenses).

Academic Editions/Users. Where Licensed Software is licensed under Licensor’s Academic Program, in
addition to the above terms and conditions:

(i) Licensee shall not use the Licensed Software for any purpose other than for non-commercial
education or academic research activities.
(ii) Licensee shall not copy the Licensed Software, nor shall Licensee distribute, transfer or assign the
Licensed Software without specific permission from Licensor.
(iii) License management: If Licensee is the academic institution using the Licensed Software for
teaching purposes, Licensee will manage all student licenses through a license server provided by
Licensor in accordance with guidelines provided by Licensor. Licensee agrees to provide reports
describing the number of licenses Licensee has issued in each period upon Licensor’s request.

Personal Edition Products.

(i) Licensee shall not use the Licensed Software for any purpose other than for personal educational
and non-commercial activities. The Licensed Software may not be used for training or teaching
purposes.
(ii) Licensee shall not copy the Licensed Software, nor shall Licensee distribute, transfer or assign the
Licensed Software without specific permission from Licensor.

Java. The Licensed Software may require Licensee to have the Java™ Platform, Standard Edition
Development Kit (JDK) or Runtime Environment (JRE) installed, and in such event Licensee is solely
responsible for obtaining and licensing the JDK or JRE directly from Oracle Corporation.

PRE-EXISTING LICENSES. FROM COMMENCEMENT OF THIS LICENSE AGREEMENT, IF THE
LICENSED SOFTWARE SUBJECT TO THIS LICENSE AGREEMENT IS THE MOST CURRENT
VERSION OF THE LICENSED SOFTWARE LICENSED BY LICENSEE, THE “LICENSED SOFTWARE”
SHALL ALSO INCLUDE, AND THIS LICENSE AGREEMENT SHALL APPLY TO, ANY PRE-EXISTING
AND FUTURE LICENSES FOR ANY EARLIER VERSION OF THE LICENSED SOFTWARE LICENSED
BY LICENSEE AND REPLACE ANY PRIOR END USER LICENSE AGREEMENTS APPLICABLE
THERETO (“PRIOR EULA(S)”). NOTWITHSTANDING THE FOREGOING, IF THE EARLIER VERSION
INCLUDES DIFFERENT COMPONENTS, ANY TERMS SPECIFICALLY APPLICABLE TO THOSE
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COMPONENTS IN THE APPLICABLE PRIOR EULA SHALL CONTINUE TO APPLY TO SUCH
COMPONENTS.

ENDS
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